CHAPTER

Service Inventory —
Inventory and Connection Manager

From the Home window of Cisco IP Solution Center (1SC), which appears upon logging in, click the

Service Inventory tab and a window as shown in Figure 3-1, “ Service Inventory Selections Window,’

appears.

Figure 3-1 Service Inventory Selections Window
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Click on Inventory and Connection Manager and a window as shown in Figure 3-2, “Inventory and
Connection Manager Selections Window,” appears.
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Figure 3-2
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From the I nventory and Connection M anager window, you can choose any of the following functions:

- Service Requests, page 3-2 Create, deploy, and manage Service Requests (SRs).

- Traffic Engineering Management, page 3-5 Create, deploy, and manage elements of Traffic
Engineering Management.

« Inventory Manager, page 3-5 Bulk-manage inventory elements.

« Topology Tool, page 3-37 View topology maps.

» Devices, page 3-70 Create and manage Devices.

» Device Groups, page 3-101 Create and manage Device Groups.

- Customers, page 3-107 Create and manage Customers.

« Providers, page 3-115 Create and manage Providers.

» Resource Pools, page 3-122 Create and manage pools for |P address, Multicast address, Route
Distinguisher, Route Target, Site of Origin, VC ID, and VLAN.

« CE Routing Communities, page 3-132 Create and manage CE Routing Communities.
» VPNs, page 3-136 Create and manage VPNs.
» Named Physical Circuits, page 3-140 Create and manage Named Physical Circuits (NPCs).

Service Requests

Service Requests are explained in each of the User Guides for each of the applicable licensed services.

Table 3-1, “Summary of Cisco IP Solution Center Service Request States,” describes each | SC service

request state. The states are listed in alphabetical order.

] Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 3-3, “Service Request States Transition Diagram,” shows the transitions of states.

Table 3-1

Summary of Cisco IP Solution Center Service Request States

Service Request State

Description

Broken

(valid only for L2TPv3
and MPLS services)

The router is correctly configured but the service is unavailable (due to a
broken cable or Layer 2 problem, for example).

An MPLS service request moves to Broken if the auditor finds the routing
and forwarding tables for this service, but they do not match the service
intent.

Closed

A serviceregquest movesto Closed if the service request should no longer be
used during the provisioning or auditing process. A service request movesto
the Closed state only upon successful audit of a decommission service
request. |SC does not remove a service request from the database to allow
for extended auditing. Only a specific administrator purge action resultsin
service requests being removed.

Deployed

A service request moves to Deployed if the intention of the service request
isfound in the router configuration file. Deployed indicates that the
configuration file has been downloaded to the router, and the intent of the
request has been verified at the configuration level. That is, | SC downloaded
the configlets to the routers and the service request passed the audit process.

Failed Audit

This state indicates that | SC downloaded the configlet to the router
successfully, but the service request did not pass the audit. Therefore, the
service did not move to the Deployed state. The Failed Audit stateis
initiated from the Pending state. After a service request is deployed
successfully, it cannot re-enter the Failed Audit state (except if the service
request is redeployed).

Failed Deploy

The cause for a Failed Deploy statusis that DCS reports that either the
upload of the initial configuration file from the routers failed or the
download of the configuration update to the routers failed (due to lost
connection, faulty password, and so on).

Functional

(valid only for L2TPv3
and MPLS services)

An MPLS service request moves to Functional when the auditor finds the
VPN routing and forwarding tables (VRF) for this service and they match
with the service intent. This state requires that both the configuration file

audit and the routing audit are successful.

Invalid

Invalid indicates that the service request information is incorrect in some
way. A service request moves to I nvalid if the request was either internally
inconsistent or not consistent with the rest of the existing network/router
configurations (for example, no more interfaces were available on the
router). The Provisioning Driver cannot generate configuration updates to
service this request.

L ost

A service request moves to L ost when the Auditor cannot find a
configuration-level verification of intent in the router configuration files.
The service request was in the Deployed state, but now some or all router
configurationinformationis missing. A servicerequest can moveto the L ost
state only when the service request had been Deployed.
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Table 3-1 Summary of Cisco IP Solution Center Service Request States (continued)

Service Request State  |Description

Pending A service request moves to Pending when the Provisioning Driver
determines that the request looks consistent and was able to generate the
required configuration updates for this request. Pending indicates that the
service request has generated the configuration updates and the
configuration updates are successfully downloaded to the routers.

The Auditor regards pending service requests as new requests and beginsthe
audit. If the service has been freshly provisioned and not yet audited, it isnot
an error (pending audit). However, if an audit is performed and the serviceis
still pending, it isin an error state.

Requested If the service is newly entered and not yet deployed, it is not an error.
However, if aDeploy isdone and it remains Requested, the serviceisin an
error state.

Wait Deploy This service request state pertains only when downloading configletsto a

Cisco CNS-CE server, such asaCisco CNS 1E2100 appliance. Wait Deploy
indicates that the configlet has been generated, but it has not been
downloaded to the Cisco CNS-CE server because the deviceis not currently
online. The configlet is staged in the repository until such time as the Cisco
CNS-CE server notifies I SC that it isup. Configletsin the Wait Deploy state
are then downloaded to the Cisco CNS-CE server.

Figure 3-3 Service Request States Transition Diagram
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Traffic Engineering Management

Traffic Engineering Management

Traffic Engineering Management allows you to create, deploy, and manage elements of Traffic
Engineering Management. Thisisexplained in detail in the Cisco | P Solution Center Traffic Engineering

Management User Guide, 4.2.

Inventory Manager

Inventory Manager provides amethod of managing mass changes to inventory and service model datain
the I SC provisioning process. In this process, Inventory Manager enables an operator to import

network-specific data into the | SC Repository (Repository) in bulk mode.
Inventory Manager performs three primary functions:

« Imports devices from configuration files and configures CPEs and PEs by associating devices with

a Customer or Provider.
- Edits devices, CPEs or PEs stored in the | SC repository.

- Assigns adeviceto a provider or customer.

Accessing the Inventory Manager Window

To access the Inventory Manager, follow these steps:

Step 1
Inventory Manager window shown in Figure 3-4.

Figure 3-4 Inventory Manager Window
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From the Inventory Manager window you can import devices or open alist of devices, providers or

customers.
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Choose Service lnventory > Inventory and Connection Manager > I nventory M anager to accessthe
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Importing Devices

To import a device, it must be in an existing directory on the same server that is running I1SC. After a
device is imported into the I SC repository, you can assign it to a customer or provider, if desired.

To import devices with configuration files, follow these steps:

Stepl  Choose Service Inventory > Inventory and Connection Manager > Inventory Manager.
Step2  Click the Import Devices button.
The Import Devices from Configuration Files window appears, as shown in Figure 3-5.

Figure 3-5 Import Devices from Configuration Files Window
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Step3  Click the Select button.
The Select Device Configuration File dialog box appears, as shown in Figure 3-6.

Figure 3-6  Select Device Configuration File Dialog
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Step4 At the Select Device Configuration File dialog box, enter the directory on the I SC server where the
configuration files reside.

Step5  Thelmport Devices from Configuration Files window appears.

Step6  Select as many of the configuration files as you want to import by checking the box to the left of the
Configuration File name.

Step7  If you want to import devices from more than one directory, you can repeat Steps 3 through 6.
Step8  Click Import.

The General Attributes window appears with the added information.
Step9  Click Save.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Opening and Editing Devices

Step 1
Step 2

Step 3

Step 4

Step 5

To open device configuration files to bulk edit, follow these steps:

Choose Service Inventory > Inventory and Connection Manager > Inventory Manager.
Click the Open button.
The Open drop-down list appears. The Open options include the following:

» Devices—Every network element that | SC manages.

~

Note  To edit a PE, Open Provider, not Open Devices.

» Provider—PEs belonging to a specific provider.
» Customer—CEs belonging to a specific customer.
Select Devices.

The Select Device window appears, as shown in Figure 3-7.

Figure 3-7 Select Devices Window
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Select a device to open by checking the check box to the left of the Device Name. You can select more
than one device to open.

Click the Select button.

The General Attributes window appears containing information on the selected devices, as shown in
Figure 3-8.

| oL-10727-01
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Inventory Manager

Step 6

Step 7

Figure 3-8  General Attributes Devices Window
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To view specific attributes click the Attributes button.
The Attributes options appear, as shown in Figure 3-9.

Figure 3-9  Attributes Options Window
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Select the type of attribute to display.
See the following sections for descriptions of these attribute fields.
e General Attributes Devices, page 3-9
» Password Attributes Devices, page 3-10
« SNMP Attributes Devices, page 3-11
« CNS Attributes Devices, page 3-12

Cisco IP Solution Center Infrastructure Reference, 4.2
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» Platform Attributes Devices, page 3-13
» Interfaces Devices, page 3-13
Step8  To bulk edit an attribute, do the following:
a. Check the one or more boxes to the left of the Device Name.
b. Check the check box above the attribute name column.
c. Click the Edit button.
Step9  Enter the changes you want to make.
Step10 Click Save.
The changes are saved.

General Attributes Devices

The General Attributes Devices window appears, as shown in Figure 3-10.

Figure 3-10 General Attributes Devices Window
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The General Attributes Devices window contains the following:

« Host —Must begin with aletter, digit, or underscore followed by letters, digits, underscores, spaces,
hyphens, or dots ending with aletter, digit, or underscore. Thisfield isrequired and must match the
name configured on the target router device. Limited to 256 characters.

» Device Type—The device type includes the following devices:
— Cisco Router

Catalyst OS device

Terminal server

IE2100 (Cisco CNS appliance)

Cisco IP Solution Center Infrastructure Reference, 4.2
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» Description—Can contain any pertinent information about the device, such as the type of device,
itslocation, or other information that might be helpful to service provider operators. Limited to 80
characters.

- Management |P Address—Valid I P address of the device that I SC uses to configure the target
router device. This IP address must be reachable from the I SC host.

- Device Domain Name—Must begin with a letter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with aletter, digit, or underscore. The hame must
match the domain name on the target router device.

« Terminal Session Protocol—Configures the method of communication between | SC and the
device. Choices include: Telnet, Secure Shell (SSH), CNS, and RSH. Default: Telnet.

» Config Access Protocol—Administers the access protocol for config upload and download.
Choices include: Terminal, TFTP, FTP, and RCP. Default: Terminal

» Device Groups—L.ists the names of the Device Groups. You can add and modify Device Groupsin
this column.

Password Attributes Devices
The Password Attributes Devices window appears, as shown in Figure 3-11.

Figure 3-11 Password Attributes Devices Window
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The Password Attributes Devices window contains the following:

« Device Name—Must begin with aletter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with aletter, digit, or underscore. Thisfield isrequired
and must match the name configured on the target router device. Limited to 256 characters.

- Login User—Not required by 1SC. However, collection and upload/download will not function
without the Login User and Login Password, as ISC will not be able to access the device. Should
match what is configured on the target router device. Limited to 80 characters.

» Login Password—Displayed as stars (*). Not required by ISC. However, collection and
upload/download will not function without the Login User and L ogin Password, as ISC will not be
able to access the device. Should match what is configured on the target router device. Limited to
80 characters.

Cisco IP Solution Center Infrastructure Reference, 4.2
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- Enable User—Not required by | SC. However, collection and upload/download only function if the
Login User has sufficient privileges to configure the router in EXEC mode. Should match what is
configured on the target router device. Limited to 80 characters.

- Enable Passwor d—Displayed as stars (*). Not required by 1SC. However, collection and
upload/download only function if the Login User has sufficient privileges to configure the router in
EXEC mode. Should match what is configured on the target router device. Limited to 80 characters.

« Community String RO —Many tasks use SNMP to access the device. This field must match what
is configured on the target router device. Limited to 80 characters.

« Community String RW— Many tasks use SNMP to access the device. Thisfield must match what
is configured on the target router device. Limited to 80 characters.

SNMP Attributes Devices

The SNMP Attributes Devices window appears, as shown in Figure 3-12.

Figure 3-12 SNMP Attributes Devices Window
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The SNMP Attributes Devices window contains the following:

» Device Name—Must begin with aletter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with aletter, digit, or underscore. Thisfieldisrequired
and must match the name configured on the target router device. Limited to 256 characters.

» SNMP Version—Choices include: SNMP v1/v2c, and SNMP v3. The default value is determined
by the setting in the DCPL property SnmpService\defaultSNMPVersion. (See Appendix C,

“Property Settings” for more details.)

» Security Level—Choices include: No Authentication/No Encryption, Authentication/No
Encryption, and Authentication/Encryption. Default: No Authentication/No Encryption.

« Authentication User Name—User name configured on the specified device router. User must have
permission to the object identification numbers (OIDs) specified in the security request (that is,
write permission for a set request, and read permission for a get request). Should match what is
configured on the target router device. Should be provisioned if the SNMP Security Level is
Authentication/No Encryption or Authentication/Encryption. Limited to 80 characters.

| oL-10727-01
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Authentication Password—Displayed as stars (*). Should be provisioned if the SNMP Security
Level is Authentication/No Encryption or Authentication/Encryption. Should match what is
configured on the target router device. Limited to 80 characters.

Authentication Algorithm—Should be provisioned if the SNMP Security Level is
Authentication/No Encryption or Authentication/Encryption. Choices include: None, MD5, and
SHA. Default: None.

Encryption Passwor d—Displayed as stars (*). In previous versions, this field was called Privacy
Password. Should match what is configured on the target router device. Should be provisioned if the
SNMP Security Level is Authentication/Encryption. Limited to 80 characters.

Encryption Algorithm—In previous versions, this field was called Privacy Protocol. Should be
provisioned if the SNMP Security Level is Authentication/Encryption. Choices include: None and
DES 56. Default: None.

CNS Attributes Devices

The CNS Attributes Devices window appears, as shown in Figure 3-13.

Figure 3-13 CNS Attributes Devices Window
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The CNS Attributes Devices window contains the following:

Device Name—Must begin with a letter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with aletter, digit, or underscore. Thisfield isrequired
and must match the name configured on the target router device. Limited to 256 characters.

| E2100 Name—Disabled unless the Device-State field is Inactive or the Terminal Session Protocol
fieldisCNS. A valid Cisco CNS 1E2100 appliance must be selected if the Terminal Session
Protocol isCNS. Choicesinclude: None and thelist of existing Cisco CNSIE2100 appliance names.
Default: None.

Device State—Choices include: Active and Inactive. Active indicates that the router has been
plugged on the network and can be part of 1SC tasks such as collect config and provisioning. Inactive
indicates the router has not been plugged-in. Default: Active.

Event | dentification—Indicates whether the CNS ldentification field contains a HOST NAME or
CNS ID. Default: HOST NAME.

CNSldentification—Required if the Event Identification field is set to CNSID. Can contain letters,
numbers, and these punctuation characters: period, underscore, and dash.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Platform Attributes Devices

The Platform Attributes Devices window appears, as shown in Figure 3-14.

Figure 3-14 Platform Attributes Devices Window
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The Platform Attributes Devices window contains the following:

« Device Name—Must begin with aletter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with aletter, digit, or underscore. Thisfield isrequired
and must match the name configured on the target router device. Limited to 256 characters.

» Platform—Should match what is configured on the target router device. Limited to 80 characters.
- Software Version—Should match what is configured on the target router device. Limited to 80

characters.

- Image Name—Should match what is configured on the target router device. Limited to 80
characters.

« Serial Number—Should match what is configured on the target router device. Limited to 80
characters.

Interfaces Devices

The Interfaces Devices window appears, as shown in Figure 3-15.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 3-15 Interfaces Devices Window
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The Interfaces Devices window contains the following:

« Host —Must begin with aletter, digit, or underscore followed by letters, digits, underscores, spaces,
hyphens, or dots ending with aletter, digit, or underscore. Thisfield isrequired and must match the
name configured on the target router device. Limited to 256 characters.

» Interface Name—Must begin with aletter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with aletter, digit, or underscore. Thisfieldisrequired.
Limited to 256 characters.

- Interface Type—Specifies the type of interface. It is a display-only field.

» Interface Description—Description of the interface. Thisfield is display-only. Field is populated
by importing a configuration file.

» InterfacelP Address—IP address associated with this interface.

« Encapsulation—The Layer 2 Encapsulation for this device. It is a display-only field. Choices
include:

- DEFAULT

- DOT1Q

- ETHERNET

- ISL

- FRAME_RELAY

- FRAME_RELAY _IETF
- HDLC

- PPP

- ATM

- AAL5SNAP

Cisco IP Solution Center Infrastructure Reference, 4.2
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» Port Type—Choicesinclude: Access, Trunk, Routed, and None.

AALO

AALS
AALSMUX
AALSNLPID
AAL2
ENCAP_QinQ
GRE

Opening and Editing PES

Step 1
Step 2

Step 3

Step 4
Step 5

To open PE files to bulk edit, follow these steps:

Inventory Manager

Choose Service Inventory > Inventory and Connection Manager > Inventory Manager.
Click the Open button.

The Open drop-down list appears. The Open options include the following:

- Devices—Every network element that | SC manages.

» Provider—PEs belonging to a specific provider.

e Customer—CEs belonging to a specific customer.
Select Provider.

The Select Provider window appears, as shown in Figure 3-16.

Figure 3-16 Select Provider Window

() select Provider - Cisco Systems, Inc.
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| Find |
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Select a provider by clicking the radio button to the left of the Provider Name.

Click the Select button.

The General Attributes window appears showing the PEs assigned to the selected provider, as shownin
Figure 3-17.
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Figure 3-17 General Attributes Provider Window
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Step6  To view specific attributes click the Attributes button.
The Attributes options appear, as shown in Figure 3-18.

Figure 3-18 Attributes Options Window
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Step7  Select the type of attribute to display.
See the following sections for descriptions of these attribute fields.
» General Attributes Provider, page 3-17
» Password Attributes Provider, page 3-18
« SNMP Attributes Provider, page 3-20
« CNS Attributes Provider, page 3-21
- Platform Attributes Provider, page 3-22
- PE Attributes Provider, page 3-23
« Interfaces Provider, page 3-24
Step8  To bulk edit an attribute, do the following:
a. Check the one or more boxes to the left of the Host or Device Name.
b. Check the check box above the attribute name column.
c. Click the Edit button.
Step9  Enter the changes you want to make.
Step10 Click Save.
The changes are saved.

General Attributes Provider

The General Attributes Provider window appears, as shown in Figure 3-19.

Figure 3-19 General Attributes Provider Window

Inventory Manager
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The General Attributes Provider window contains the following:

Host —Must begin with aletter, digit, or underscore followed by letters, digits, underscores, spaces,
hyphens, or dots ending with aletter, digit, or underscore. Thisfield isrequired and must match the
name configured on the target router device. Limited to 256 characters.

Device Type—The device type includes the following devices:
— Cisco Router
— Catalyst OS device
— Terminal server
— IE2100 (Cisco CNS appliance)

Description—Can contain any pertinent information about the device, such as the type of device,
its location, or other information that might be helpful to service provider operators. Limited to 80
characters.

Management |P Address—Valid |P address of the device that |SC uses to configure the target
router device. This IP address must be reachable from the I SC host.

Device Domain Name—Must begin with aletter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with aletter, digit, or underscore. The name must
match the domain name on the target router device.

Terminal Session Protocol—Configures the method of communication between 1SC and the
device. Choices include: Telnet, Secure Shell (SSH), CNS, and RSH. Default: Telnet.

Config Access Protocol—Administers the access protocol for config upload and download.
Choices include: Terminal, TFTP, FTP, and RCP. Default: Terminal

Device Groups—Lists the names of the Device Groups. You can add and modify Device Groupsin
this column.

Password Attributes Provider

The Password Attributes Provider window appears, as shown in Figure 3-20.
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Figure 3-20 Password Attributes Provider Window
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The Password Attributes Provider window contains the following:

Device Name—Must begin with a letter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with aletter, digit, or underscore. Thisfield isrequired
and must match the name configured on the target router device. Limited to 256 characters.

L ogin User—Not required by ISC. However, collection and upload/download will not function
without the Login User and Login Password, as ISC will not be able to access the device. Should
match what is configured on the target router device. Limited to 80 characters.

L ogin Passwor d—Displayed as stars (*). Not required by 1SC. However, collection and
upload/download will not function without the Login User and Login Password, as ISC will not be
able to access the device. Should match what is configured on the target router device. Limited to
80 characters.

Enable User—Not required by 1SC. However, collection and upload/download only function if the
Login User has sufficient privileges to configure the router in EXEC mode. Should match what is
configured on the target router device. Limited to 80 characters.

Enable Password—Displayed as stars (*). Not required by | SC. However, collection and
upload/download only function if the Login User has sufficient privileges to configure the router in
EXEC mode. Should match what is configured on the target router device. Limited to 80 characters.

Community String RO —Many tasks use SNMP to access the device. This field must match what
is configured on the target router device. Limited to 80 characters.

Community String RW— Many tasks use SNMP to access the device. This field must match what
is configured on the target router device. Limited to 80 characters.

| oL-10727-01
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SNMP Attributes Provider

The SNMP Attributes Provider window appears, as shown in Figure 3-21.

Figure 3-21 SNMP Attributes Provider Window
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The SNMP Attributes Provider window contains the following:

» Device Name—Must begin with aletter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with aletter, digit, or underscore. Thisfield isrequired
and must match the name configured on the target router device. Limited to 256 characters.

« SNMP Version—Choices include: SNMP v1/v2c, and SNMP v3. The default value is determined
by the setting in the DCPL property SnmpService\defaultSNMPVersion. (See Appendix C,
“Property Settings” for more details.)

» Security Level—Choices include: No Authentication/No Encryption, Authentication/No
Encryption, and Authentication/Encryption. Default: No Authentication/No Encryption.

» Authentication User Name—User name configured on the specified device router. User must have
permission to the object identification numbers (OIDs) specified in the security request (that is,
write permission for a set request, and read permission for a get request). Should match what is
configured on the target router device. Should be provisioned if the SNMP Security Level is
Authentication/No Encryption or Authentication/Encryption. Limited to 80 characters.

» Authentication Password—Displayed as stars (*). Should be provisioned if the SNMP Security
Level is Authentication/No Encryption or Authentication/Encryption. Should match what is
configured on the target router device. Limited to 80 characters.

« Authentication Algorithm—Should be provisioned if the SNMP Security Level is
Authentication/No Encryption or Authentication/Encryption. Choices include: None, MD5, and
SHA. Default: None.

« Encryption Password—Displayed as stars (*). In previous versions, this field was called Privacy
Password. Should match what is configured on the target router device. Should be provisioned if the
SNMP Security Level is Authentication/Encryption. Limited to 80 characters.

« Encryption Algorithm—In previous versions, this field was called Privacy Protocol. Should be
provisioned if the SNMP Security Level is Authentication/Encryption. Choices include: None and
DES 56. Default: None.

Cisco IP Solution Center Infrastructure Reference, 4.2




| Chapter3 Service Inventory — Inventory and Connection Manager

Inventory Manager ||

CNS Attributes Provider

The CNS Attributes Provider window appears, as shown in Figure 3-22.

Figure 3-22 CNS Attributes Provider Window
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The CNS Attributes Provider window contains the following:

- Device Name—Must begin with aletter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with aletter, digit, or underscore. Thisfield isrequired
and must match the name configured on the target router device. Limited to 256 characters.

- |E2100 Name—Disabled unless the Device-State field is Inactive or the Terminal Session Protocol
fieldisCNS. A valid Cisco CNS IE2100 appliance must be selected if the Terminal Session
Protocol is CNS. Choicesinclude: None and the list of existing Cisco CNS IE2100 appliance names.
Default: None.

- Device State—Choices include: Active and Inactive. Active indicates that the router has been
plugged on the network and can be part of 1SC tasks such as collect config and provisioning. Inactive
indicates the router has not been plugged-in. Default: Active.

« Event ldentification—Indicates whether the CNS Identification field contains a HOST NAME or
CNSID. Default: HOST NAME.

« CNSldentification—Required if the Event Identification field isset to CNSID. Can contain letters,
numbers, and these punctuation characters: period, underscore, and dash.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Platform Attributes Provider

The Platform Attributes Provider window appears, as shown in Figure 3-23.

Figure 3-23 Platform Attributes Provider Window
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The Platform Provider window contains the following:

» Device Name—Must begin with aletter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with aletter, digit, or underscore. Thisfield isrequired
and must match the name configured on the target router device. Limited to 256 characters.

» Platform—Should match what is configured on the target router device. Limited to 80 characters.

» Software Version—Should match what is configured on the target router device. Limited to 80
characters.

» Image Name—Should match what is configured on the target router device. Limited to 80
characters.

» Serial Number—Should match what is configured on the target router device. Limited to 80
characters.
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PE Attributes Provider

The PE Attributes Provider window appears, as shown in Figure 3-24.

Figure 3-24 PE Attributes Provider Window
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The PE Attributes Provider window contains the following:

Device Name—Must begin with aletter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with aletter, digit, or underscore. Thisfield isrequired
and must match the name configured on the target router device. Limited to 256 characters.

Provider—Lists the names of providers. Must begin with aletter. Can contain letters, numbers, and
these punctuation characters: period, underscore, and dash. Limited to 80 characters. You can sort
the list by provider name.

Region—L.ists the names of regions. Must begin with aletter. Can contain letters, numbers, and
these punctuation characters: period, underscore, and dash. Limited to 80 characters. You can sort
the list by region name.

Role—Choices include: N-PE, U-PE, P, PE_AGG.

L oopback Interface—L oopback address is the | P address of any loopback interface on the device.
You can select one of the loopback interfaces for this field and use the IP address on that |oopback
interface.

M anaged—Provisioned by | SC. Check the check box for yes. Default is no.

| oL-10727-01
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Interfaces Provider

The Interfaces Provider window appears, as shown in Figure 3-25.

Figure 3-25 Interfaces Provider Window
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The Interfaces Provider window contains the following:

» Host —Must begin with aletter, digit, or underscore followed by letters, digits, underscores, spaces,
hyphens, or dots ending with aletter, digit, or underscore. Thisfield is required and must match the
name configured on the target router device. Limited to 256 characters.

- Interface Name—Must begin with aletter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with aletter, digit, or underscore. Thisfieldisrequired.
Limited to 256 characters.

- Interface Type—Specifies the type of interface. It is a display-only field.

« Interface Description—Description of the interface. Thisfield is display-only. Field is populated
by importing a configuration file.

« Interface |P Address—IP address associated with this interface.

« Encapsulation—The Layer 2 Encapsulation for this device. It is a display-only field. Choices
include:

— DEFAULT
— DOTIQ

— ETHERNET
~IsL

- FRAME_RELAY
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- FRAME_RELAY_IETF
- HDLC
- PPP
- ATM
— AALSSNAP
- AALO
- AALS
- AAL5SMUX
— AALSNLPID
- AAL2
- ENCAP_QinQ
- GRE
» Port Type—Choicesinclude: Access, Trunk, Routed, and None.

Opening and Editing CEs

To open CE files to bulk edit, follow these steps:

Stepl  Choose Service Inventory > Inventory and Connection Manager > Inventory Manager.
Step2  Click the Open button.
The Open drop-down list appears. The Open options include the following:
- Devices—Every network element that | SC manages.
» Provider—PEs belonging to a specific provider.
» Customer—CEs belonging to a specific customer.
Step3  Select Customer.
The Select Customer window appears, as shown in Figure 3-26.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 3-26 Select Customer Window
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Step4  Select a customer by clicking the radio button to the left of the Customer Name.
Step5  Click the Select button.

The General Attributes window appears showing the CEs assigned to the selected customer, as shownin
Figure 3-27.

Figure 3-27 General Attributes Customer Window
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Step6  To view specific attributes click the Attributes button.
The Attributes options appear, as shown in Figure 3-28.
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Figure 3-28 Attributes Options Window

Inventory Manager

General Attributes - CE= for Customer Customer1

Shovwy entries with Host matching *

Showing 1 - 3 of 3 records

R [] [] [] L] [] L]
# D o EvIE TVpe Description Management Device Domain Mame  Terminal Config Device
IP Address Sanainn Access Groups
General Attributes Protocol
1. O ced Cis':f':' 103 Password Attributes  [Default
Device
> 0O cel3  Ciscol0S SHMP Attributes Default
Derice CHS Attributes
5 D ced Cizco (05 Defautt
’ Device Platform Attributes
Rowes per page: [ 10w CPE Attributes Bl 1 of 1 20
Interfaces
Attributes " ‘ | | Save ‘

158145

Step7  Select the type of attribute to display.
See the following sections for descriptions of these attribute fields.
« General Attributes Customer, page 3-28
» Password Attributes Customer, page 3-29
» SNMP Attributes Customer, page 3-30
» CNS Attributes Customer, page 3-31
» Platform Attributes Customer, page 3-32
« CPE Attributes Customer, page 3-33
« Interfaces Customer, page 3-34
Step8  To bulk edit an attribute, do the following:
a. Check the one or more boxes to the left of the Host or Device Name.
b. Check the check box above the attribute name column.
c. Click the Edit button.
Step9  Enter the changes you want to make.
Step10 Click Save.
The changes are saved.
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General Attributes Customer

The General Attributes Customer window appears, as shown in Figure 3-29.

Figure 3-29 General Attributes Customer Window
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The General Attributes Customer window contains the following:

Host —Must begin with aletter, digit, or underscore followed by letters, digits, underscores, spaces,
hyphens, or dots ending with aletter, digit, or underscore. Thisfield isrequired and must match the
name configured on the target router device. Limited to 256 characters.

Device Type—The device type includes the following devices:
— Cisco Router
— Catalyst OS device
— Terminal server
— |E2100 (Cisco CNS appliance)

Description—Can contain any pertinent information about the device, such as the type of device,
its location, or other information that might be helpful to service provider operators. Limited to 80
characters.

Management |P Address—Valid IP address of the device that | SC uses to configure the target
router device. This IP address must be reachable from the | SC host.

Device Domain Name—Must begin with aletter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with aletter, digit, or underscore. The name must
match the domain name on the target router device.

Terminal Session Protocol—Configures the method of communication between 1SC and the
device. Choices include: Telnet, Secure Shell (SSH), CNS, and RSH. Default: Telnet.

Config Access Protocol—Administers the access protocol for config upload and download.
Choicesinclude: Terminal, TFTP, FTP, and RCP. Default: Terminal

Device Groups—Lists the names of the Device Groups. You can add and modify Device Groupsin
this column.
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The Password Attributes Customer window appears, as shown in Figure 3-30.

Figure 3-30 Password Attributes Provider Window
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The Password Attributes Customer window contains the following:

Device Name—Must begin with aletter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with aletter, digit, or underscore. Thisfield isrequired
and must match the name configured on the target router device. Limited to 256 characters.

L ogin User—Not required by ISC. However, collection and upload/download will not function
without the Login User and Login Password, as ISC will not be able to access the device. Should
match what is configured on the target router device. Limited to 80 characters.

L ogin Passwor d—Displayed as stars (*). Not required by 1SC. However, collection and
upload/download will not function without the Login User and Login Password, as ISC will not be
able to access the device. Should match what is configured on the target router device. Limited to
80 characters.

Enable User—Not required by 1SC. However, collection and upload/download only function if the
Login User has sufficient privileges to configure the router in EXEC mode. Should match what is
configured on the target router device. Limited to 80 characters.

Enable Password—Displayed as stars (*). Not required by |SC. However, collection and
upload/download only function if the Login User has sufficient privileges to configure the router in
EXEC mode. Should match what is configured on the target router device. Limited to 80 characters.

Community String RO —Many tasks use SNMP to access the device. This field must match what
is configured on the target router device. Limited to 80 characters.

Community String RW— Many tasks use SNMP to access the device. This field must match what
is configured on the target router device. Limited to 80 characters.

| oL-10727-01
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SNMP Attributes Customer

The SNMP Attributes Customer window appears, as shown in Figure 3-31.

Figure 3-31 SNMP Attributes Customer Window
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The SNMP Attributes Customer window contains the following:

- Device Name—Must begin with aletter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with aletter, digit, or underscore. Thisfield isrequired
and must match the name configured on the target router device. Limited to 256 characters.

« SNMP Version—Choices include: SNMP v1/v2c, and SNMP v3. The default value is determined
by the setting in the DCPL property SnmpService\default SNM PVersion. (See Appendix C,
“Property Settings” for more details.)

» Security Level—Choices include: No Authentication/No Encryption, Authentication/No
Encryption, and Authentication/Encryption. Default: No Authentication/No Encryption.

« Authentication User Name—User name configured on the specified device router. User must have
permission to the object identification numbers (OIDs) specified in the security request (that is,
write permission for a set request, and read permission for a get request). Should match what is
configured on the target router device. Should be provisioned if the SNMP Security Level is
Authentication/No Encryption or Authentication/Encryption. Limited to 80 characters.

» Authentication Password—Displayed as stars (*). Should be provisioned if the SNMP Security
Level is Authentication/No Encryption or Authentication/Encryption. Should match what is
configured on the target router device. Limited to 80 characters.

» Authentication Algorithm—Should be provisioned if the SNMP Security Level is
Authentication/No Encryption or Authentication/Encryption. Choices include: None, MD5, and
SHA.. Default: None.

« Encryption Password—Displayed as stars (*). In previous versions, this field was called Privacy
Password. Should match what is configured on the target router device. Should be provisioned if the
SNMP Security Level is Authentication/Encryption. Limited to 80 characters.

« Encryption Algorithm—In previous versions, this field was called Privacy Protocol. Should be
provisioned if the SNMP Security Level is Authentication/Encryption. Choices include: None and
DES 56. Default: None.
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CNS Attributes Customer

The

Figu

CNS Attributes Customer window appears, as shown in Figure 3-32.

re 3-32 CNS Attributes Customer Window
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The CNS Attributes Customer window contains the following:

Device Name—Must begin with aletter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with aletter, digit, or underscore. Thisfield isrequired
and must match the name configured on the target router device. Limited to 256 characters.

| E2100 Name—Disabled unless the Device-State field is I nactive or the Terminal Session Protocol
fieldisCNS. A valid Cisco CNS IE2100 appliance must be selected if the Terminal Session
Protocol is CNS. Choicesinclude: None and thelist of existing Cisco CNS IE2100 appliance hames.
Default: None.

Device State—Choices include: Active and Inactive. Active indicates that the router has been
plugged on the network and can be part of 1SC tasks such as collect config and provisioning. Inactive
indicates the router has not been plugged-in. Default: Active.

Event | dentification—Indicates whether the CNS ldentification field contains a HOST NAME or
CNSID. Default: HOST NAME.

CNSldentification—Required if the Event Identification field isset to CNSID. Can contain letters,
numbers, and these punctuation characters: period, underscore, and dash.

| oL-10727-01
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Platform Attributes Customer

The Platform Attributes Customer window appears, as shown in Figure 3-33.

Figure 3-33 Platform Attributes Customer Window

Platform Attributes

Platform Attributes - CEs for Customer Customer1

Show entries with Host matching I | Find |

Showing 1 - 3 of 3 records

| I | | I |

# )
L Device Name Platfarm Software Yersion Image Name Serial Mumber
1. ce3 2621 12.2{5d}) C2600-J8-Mc2600-j5-mz.122-16.6
2. [ ced 2621 12.2{5d}) C2600-J5-Mc2600-j5-mz.122-16.6
3. cel3 2621 12.2{5d}) C2600-J8-Mc2600-j5-mz.122-16.6
Rows perpage:lm | 1<) Gota page:|1 of 1 [0
| Attributes ¥ || || Save |
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The Platform Customer window contains the following:

» Device Name—Must begin with aletter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with aletter, digit, or underscore. Thisfield isrequired
and must match the name configured on the target router device. Limited to 256 characters.

- Platfor m—Should match what is configured on the target router device. Limited to 80 characters.

- Software Ver sion—Should match what is configured on the target router device. Limited to 80

characters.

« Image Name—Should match what is configured on the target router device. Limited to 80
characters.

» Serial Number—Should match what is configured on the target router device. Limited to 80
characters.
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CPE Attributes Customer

The CPE Attributes Customer window appears, as shown in Figure 3-34.

Figure 3-34 CPE Attributes Customer Window

CPE Attributes

CPE Attributes for Customer Customer1

Show entries with Host matching I | Find |

Showing 1 - 3 of 3 records

r _ I I
Dewice Name Custamer s Management Type
1. [~ ce3d Custameri east Managed
2. [ ced Custamert east Managed
3 [ cel3 Custameri east Managed
Rows perpage:lm | 1<) Gota page:|1 of 1 [0
| Attributes ¥ | | | | Save |

Mote: * - Required Field

149316

The CPE Attributes Customer window contains the following:

« Device Name—Must begin with aletter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with aletter, digit, or underscore. Thisfield isrequired
and must match the name configured on the target router device. Limited to 256 characters.

» Customer—Lists the names of customers. Must begin with aletter. Can contain letters, numbers,
and these punctuation characters: period, underscore, and dash. Limited to 80 characters. You can
sort the list by customer name.

- Site—Liststhe names of sites. Must begin with a letter. Can contain letters, numbers, and these
punctuation characters: period, underscore, and dash. Limited to 80 characters. You can sort the list
by site name.

- Management Type—Choices include: Managed, Unmanaged, Managed - Management LAN,
Unmanaged - Management LAN, Directly Connected, Directly Connected Management Host,
Multi-VRF, and Unmanaged Multi-VRF.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Interfaces Customer

The Interfaces Customer window appears, as shown in Figure 3-35.

Figure 3-35 Interfaces Customer Window

Interface Attributes

Interfaces - CEs for Customer Customer1

Show entries with Host matching I | Find |

Showing 1-10 of 12 recards

i " I I I
Host Interface Narme Interface Type Interface Description Interface IP Address Encapsulation  Port Type
1. ce3 Ethernetlin ethernet 17229146 26026 Maone
2. [ ce3 Ethernet0i1 ethernet Mone
3. ce3 Ethernetliz ethernet Maone
4. [ ce3 Ethernetli3 ethernet Mone
5 [ ce3 Serial1f0 searial Maone
6. [ ce3 Serialli searial Mone
7. ce3 Serial1s2 searial Maone
8. [ ce3 Serial1f3 searial Mone
g [ cesd FastEthernetdill  fastethernet 1722914631026 Maone
10. [ cesd FastEthernetdil  fastethernet L7: Link To sw3 Mone
Rows perpage:lﬂ 144 Goto page:|1—0f2 BRI
| Attributes ¥ | | | | Save |
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The Interfaces Customer window contains the following:

Host —Must begin with aletter, digit, or underscore followed by letters, digits, underscores, spaces,
hyphens, or dots ending with aletter, digit, or underscore. Thisfield isrequired and must match the
name configured on the target router device. Limited to 256 characters.

Inter face Name—Must begin with aletter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with aletter, digit, or underscore. Thisfieldisrequired.
Limited to 256 characters.

Interface Type—Specifies the type of interface. It is a display-only field.

Interface Description—Description of the interface. This field is display-only. Field is popul ated
by importing a configuration file.

Interface | P Address—IP address associated with this interface.

Encapsulation—The Layer 2 Encapsulation for this device. It is a display-only field. Choices
include:

— DEFAULT
— DOTIQ

— ETHERNET

~IsL

- FRAME_RELAY

— FRAME_RELAY _|ETF
— HDLC

— PPP

Cisco IP Solution Center Infrastructure Reference, 4.2
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- ATM

— AALSSNAP
— AALO

— AALS5

— AAL5MUX
— AALS5NLPID
~ AAL2

— ENCAP_QinQ
- GRE

« Port Type—Choices include: Access, Trunk, Routed, and None.

Assigning Devices

To assign a device to a provider or customer, follow these steps:

Stepl  Choose Service Inventory > Inventory and Connection Manager > Inventory M anager.
Step2  Click the Open button.
The Open drop-down list appears, as shown in Figure 3-37.

Figure 3-36  Open Options Window

Inventory Manager

I Fmnd |

P -I..

Import Devices m

Devices

Provider

Customer

158146

Step3  Select Devices.

The Select Device window appears, as shown in Figure 3-37.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 3-37 Select Devices Window

I'.EJ Select Device(s) - Cisco Systems, Inc. — |EI|1|
Show Devices with I Device Mame | matering r‘ | Find |
Showing 1 - 8 of 8 records
_ Management IP Parent Device
* u bece Hame Address Type Name
1. I~ pet Ciscn 105 Device
2. [ pel Cisco 105 Device
3 I~ w2 Cisco 108 Device
4, [ w3 Cisco 105 Device
5. I~ Swid Ciscn 105 Device
f. [ celd Cisco 105 Device
7. I~ ced Cisco 105 Device
2. [ cel 3 Cisco 108 Device
Rows per page: | 10 | 144 Gota page:|1 of 1 (2 [l
| Select || Cancel |
o
u
o
o
=

Step4  Select adevice to open by checking the box to the left of the Device Name. You can select more than
one device to open.

Step5  Click the Select button.

The General Attributes window appears containing information on the selected devices, as shown in
Figure 3-38.

Figure 3-38 General Attributes Devices Window

Inventory Manager

General Attributes - Devices

Show entries with Host matching Ibk | Find |
Showing 1- 3 of 3 records
_ | I | I I I
# Haost Device Type Description Managemment  Device Domain Tetminal Confiy  Device Groups
IP Address Mame Session Access
Protocal Protocal
pel Cisco 108 Diefault Diefault Device-Group-1
1. .
Device
ped Cigco 108 Default Default Device-Group-2
2. :
Device
2| [ar W2 Cisco 108 Default Default
’ Device
Rowes per page: | 10 j 14 <] Goto page:|1 of 1 [> (=1
Attributes v || Assign CEPE '|| Edit || Save | @
(=
=3

Step6  Click the Assign CE/PE button.
Step7  Select Customer or Provider.

The corresponding Select Customer or Select Provider window appears, as shown in Figure 3-39.
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Figure 3-39 Select Provider Window

() select Provider - Cisco Systems, Inc. 1Ol x|

Show Providers with Pravider Mame matching IW | Find |

Showing 1 -1 of 1 record
# Provider Hame

1. & Provideri
Rows per page:l 10 j 1< 4 Goto page:l1 af 1 [ [=0

| Select || Cancel |
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Step8  Select the customer or provider to which you want to assign the device by checking the box to the left
of the Customer or Provider Name.

Step9  Click the Select button.

If you assigned the device to a provider, the PE Attributes window appears. If you assigned the device
to a customer, the CPE Attributes window appears.

Step 10  In order to save the assigned devices to the | SC repository, you must specify the Site in the CPE
Attributes window or the Region in the PE Attributes window. Do the following:

a. Check the one or more boxes to the left of the Device Name.
b. Check the check box above the Site or Region column.
c. Click the Edit button. The Edit Attributes window appears.
d. Click Select. The Select Site or Select Region window appears.
e. Select asite or region by checking the box to the left of the Site Name or Region Name.
f. Click Save.
Step 11  You can choose to edit attributes as desired. Enter any changes you want to make.
Step12 Click Save.
The PE or CPE is saved to the I SC repository.

Topology Tool

The topology tool provides a graphical view of networks set up through the |SC web client. It gives a
graphical representation of the various physical and logical parts of the network, both devices and links.

« Introduction, page 3-38
» Launching Topology Tool, page 3-38
» Conventions, page 3-40
» Accessing the Topology Tool for ISC-VPN Topology, page 3-43
« Types of Views, page 3-45
— VPN View, page 3-46

Cisco IP Solution Center Infrastructure Reference, 4.2
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— Logical View, page 3-51

— Physical View, page 3-54
» Viewing Device and Link Properties, page 3-55
» Filtering and Searching, page 3-62

— Filtering, page 3-62

— Searching, page 3-65
- Using Maps, page 3-66

— Loading a map, page 3-67

Layers, page 3-68

Map data, page 3-69

Node locations, page 3-69
— Adding new maps, page 3-70

Introduction

The topology tool includes three types of views:

« VPN view—shows connectivity between customer devices. The VPN view also gives an aggregate
view of all services and individual logical and physical views of each of the services.

» Logical view—shows logical connections set up in a selected provider region
» Physical view—displays connectivity of named physical circuitsin a provider region.
In addition, this chapter describes the following features:

» Filtering and Searching—filter out unnecessary detail in large graphs or jump straight to a particular
device using the search tool

» Using Maps—associate maps with the individual views.

Please note that some details, such as window decorations, are system specific and might appear
differently in different environments. However, the functionality should remain consistent.

Launching Topology Tool

To launch the Topology Tool, follow these steps:

Stepl Loginto ISC.

Step2  Choose Service Inventory > Inventory and Connection Manager > Topology Tool and a window
appears, as shown in Figure 3-40, “Topology Launch Window.” If you do not have the proper Java
Runtime Environment (JRE) as specified at the bottom of the window, click the corresponding link for
your system, follow that path, then quit the browser, log in again, and go back to the Topology Tool page.
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Figure 3-40 Topology Launch Window

Topology Tool

“iewy topology maps.

e ISC-VPH Topology

*”n'\::t Launches a Java™ Wieh Start application that presents graphical vieswws of YPhs, Regions, and Access
st Domains.

W ISC-TEM Topology Interface Applet
*”n'\::t Launches the ISC-TEM Topology Interface Applet.

Java Runtime Environment (JRE) and Java Webstart must be installed to run Invertory Manager . If you are having trouble
getting them to function properly or need to update your local JRE plesse dovwnload and install one approgriste for your
operating system.

JRE Description Platform Yersion Supported
Windowes (all languages, including Englizh) Windoves 142 04 Yes
Solariz SPARC 32-bit self-extracting file Solariz SPARC 142 04 ez
Linwx zelf-extracting file LirLe 142 04 Mo

101966

Step3  Click ISC-VPN Topology in Figure 3-40, “Topology Launch Window” to launch the Topology Tool
application on the web client. This starts up the Java Web Start application.

Note  Name resolution isreguired. The ISC HTTP server host must be in the Domain Name System (DNYS)
that the web client is using or the name and address of the ISC server must be in the client host file.

Step4  Thefirst time Inventory Manager is activated, the Security Warning window in Figure 3-41 appears.
Click Start to proceed or Details to verify the security certificate.

Figure 3-41 Security Warning Window

Security Warning @

(‘—- Do you want to trust the signed application distributed by WPNSC
<> Engineering
"

Warning: Failed to verify the authenticity of this cedificate. Mo assertions
can be made of the arigin or validity of the code.

Itis highly recommended not ta install and run this code,

| start || Dpetaits || Exit |

149150

Step5  The Desktop Integration window in Figure 3-42 appears. Click Yes to integrate into your desktop
environment, click No to decline, click Ask Later to be prompted the next time VPN Topology is
invoked, or click Configure ... to customize the desktop integration.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 3-42 Topology Desktop Integration Window
ISC 4.1 - Topology - Desktop Integration E|
( Desktop Integration provides a guick and easy
--_‘: wiay to access your application.
— |
S——  Would you like to have "ISC 4.1 - Topology”
integrated into your desktop enviornment ?
| Yes | | No | | Ask Later | | Configure ... | iy
o
+

The Loginwindow in Figure 3-43, “Log In to I1SC Window.” appears whether or not a selection has been
made in the Desktop Integration window.

Figure 3-43 Log In to ISC Window
Fleasze login...
User Name: | |
Fassword: | |
| OK || Cancel | %

Step6  Enter your User Name and Password and click OK. The Topology Tool launches and connects to the
Master ISC server.

Conventions

Topology software uses several conventions to visually communicate information about displayed
objects. The shape and color of a node representing a device depends on the role of the device, as shown
in Table 3-2.
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Table 3-2

Topology Tool

Device Role Shapes

Shape

Description

g device-b.doman.com

Customer Name
Site B Mame
LEE.0.0.1
Description of device-D

SPOKE

111655

Greenicon for a CAT OS customer device followed by the
following information:

- Device name

- Customer Name

- Site Name

- Management IP Address

- Description

- Role (SPOKE or HUB of aVPN)

55 dewice-asdomain.com

Customer Name
Site & Mame
LE0.0.0.0
Description of device-a

_ SPOKE

111684

Green icon for arouter customer device followed by the
following information:

- Device name

- Customer Name

- Site Name

- Management |P Address

- Description

- Role (SPOKE or HUB of a VPN)

e Ethernetd/1

173,234
Default
Facleet Over SONET

111686

Green icon for an interface followed by the following
information:

- Interface name

- Management IP Address
- Encapsulation Type

- Interface Type

23 device-Ldomian.com

Frovider Mame
Feqgion 1 Name
177.0.0.1
Description of device-1
M-PE

111657

Blueicon for a CAT OS provider device followed by the
following information:

- Device name

- Provider Name

- Region Name

- Management IP Address
- Description

- Role

& device-0.domain.com

Provider Mame
Fegion 1 Name
177000
Description of device-0
i-FE

111655

Blueicon for arouter provider device followed by the
following information:

- Device name

- Provider Name

- Region Name

- Management | P Address
- Description

- Role
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Table 3-2 Device Role Shapes (continued)

Shape Description

Blueicon for aregion followed by the following
information:

g Region 1 Name
o - Region name
Frovider Name A - Provider Name

Green icon for a site followed by the following

By Site C Name information:

- Site name

- Customer Name

- Role in which Site’'s device joined VPN (HUB, SPOKE,
or combination of HUB and SPOKE)

Customer Name
HUE

111590

Green icon for a site followed by the following

By Site A Name information:

- Site name

- Customer Name

- Role in which Site's device joined VPN (HUB, SPOKE,
or combination of HUB and SPOKE)

Customer Name
SPOKE

111691

A distinct color scheme is used to highlight the link type as shown in Table 3-3:

Table 3-3 Link Type Color Scheme

Color Connection Type

End-to-end wire

(green)

Attachment circuit

(purple)

MPLS VPN link

(brown)
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Finally, the four patterns shown in Table 3-4 are used to indicate the service request state:

Table 3-4 Link State Pattern Scheme

Pattern Service Request State

Deployed, functional, pending

Failed audit, invalid, broken, lost

Wait deploy, requested, failed deploy

Closed

Accessing the Topology Tool for ISC-VPN Topology

Launch the Topology Tool as explained in Figure 3-40, “Topology Launch Window,” in the “ Launching
Topology Tool” section on page 3-38 and then use the following steps to access the | SC-VPN Topology
tool.

Stepl  Choose Service Inventory > Inventory and Connection Manager > Topology Tool > 1SC-VPN
Topology.

The Topology window shown in Figure 3-44 appears.

Cisco IP Solution Center Infrastructure Reference, 4.2
[ oL-10727-01 .m



Chapter 3 Service Inventory — Inventory and Connection Manager |

M Topology Tool

Figure 3-44 Topology Application Window

IP Solution Center - Topology Viewer [connected to wxyz-ul0.cisco.com as admin

File Edit Yiew Map Help
= e e ENENEY

: Name contains: | 4 Advanced...

[ Unnamed 1

[«]

l Unnamed

111692

The application window is divided into four areas, as shown in Figure 3-44:

« area(1)—Thetop left corner shows the Overview area. The colored rectangular panel, called the
panner, corresponds to the area currently visible in the main area. Moving the panner around
changes the part of the graph showing in the main area. Thisis particularly useful for large graphs.

- area(2)—The bottom left area shows the Tree View of the graph. When no graph is shown, asingle
node called Unnamed is displayed. When a graph is shown, atree depicting devices and their
possible interfaces and connections is displayed. The tree can be used to quickly locate a device or
a connection.

- area(3)—The main area (Main View) of the window shows a graph representing connections
between devices. The name of the displayed network is shown at the bottom. When no view is
present, the name defaults to Unnamed.

- area(4)—Above the main window is the Filter area. It allows you to filter nodes by entering a
pattern. Nodes whose name contains the entered pattern maintain the normal level of brightness. All
other nodes and edges become dimmed, as shown in Figure 3-66 and the “Filtering” section on
page 3-62.

~

M: The bottom bar below all the areas, is a Status bar.

Views are loaded, saved, and closed using the File menu, as shown in Figure 3-45.
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Figure 3-45 The File Menu

P Saluthen Center - Topalopy Yhewer [conmected to weyz-u10 cise
flo E View Hep el
I o S - [-|8|&]a] (B
S -5 o
Expart. -_mem
Save A1
Close o
Close &il
P, cw

xarm a5 admin]

o FastEthesnet? s, 143
wigeT
1388100
sotin
VLA 143
eea wun

NS
Y mipes
Dy miceis
D mlpe?

9 O connections
DY Fastememets 1234 -
DY FastEmemetin 144 - m|
D) FastEmemern 143 - mi |
D mice16 - mipas s

g aE thernen 8§42

10.44.100
0TI

e LA 1234
e | ~
108.0.100 show
BOTIG |
LAN 144
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The File menu contains the following menu items:
« Open—Opens aview.
» Save—Saves the open and active view with the existing file name, if any.

Export...—Exports the active view in either Scalable Vector Graphics (SVG), Joint Photographics
Expert Group (JPG), or Portable Network Graphics (PNG) format.

- Save All—Saves all open views.

» Close—Closes the open and active view.
» Close All—Closes all open views.

e Print...—Prints the open and active view.
» Exit— Exits the Topology tool.

Types of Views

There are three view panes in the topology application and they are described in the following sections:
- VPN View, page 3-46, shows connectivity between devicesin a VPN
« Logical View, page 3-51, shows connectivity between PEs and CPEs in aregion
» Physical View, page 3-54, shows physical devices and links for PEsin a region.

The view attributes can be changed using the View menu, as shown in Figure 3-46.

| oL-10727-01
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Figure 3-46 The View Menu

= IP Solution Center - Topology Viewer [connected towxpz -u10.cis n 3z adrnin]

Zoom In Pag Dimes
ZoomOut  Fanelp "* F""‘I“’:"""“‘
: { mipe
33 Frov_a. Ceiesh R '1;: .'-'?a
# Ddevices ) micets VLAN 144
[y Reg_s Custemart ! =
D enpeld -
D enped
D miped
D miceld
D mipel
O miswio
¢ O connections
[ FasiEthormet s 144 - m|
[ FastEthormet 26,1234 - n
) micet6 - mipes

e Fasti thesmet? 51234

mipe’

10,44 1730
poTIO

VLAN 1234
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The View menu contains the following menu items:

« Anti-Aliasing—When drawing a view, this creates smoother lines and a more pleasant appearance
at the expense of performance.

» Grid—Activates a magnetic grid. The grid has a 10 by 10 spacing and can be used to help align
nodesin aview.

» Auto-L ayout—Generates an automatic layout of nodes in aview. If selected, the program tries to
find the most presentable arrangement of nodes.

- Zoom—Opens a dialog where the desired magnification level can be specified.
e Zoom In— Increases the magnification level.

» Zoom Out—Decreases the magnification level.

» Refresh—Regenerates the view. Thisis especially useful if the data in the repository changes. To
see an updated view, select Refresh or click the Refresh toolbar button.

VPN View

The VPN view shows connectivity between devices forming a given VPN. To activate the VPN view,
follow these steps:

Step1  Inthe menu bar, select File > Open.
or

click the Open button in the tool bar.

The Folder View window in Figure 3-47 appears displaying a directory tree with available VPNs.
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Step 2

Step 3

Aggregate View

Figure 3-47

Folder View Window

EE LT FrovIiTer
¢ CwPNs
&= [ ATaM_VPN
% I L2TPv3_WPH
B @ [ |Layer 2
E Logical View
E Physical Wiew
& I MPLS
I8 aggreoate View
9 CIMPLS_WPN
& I MPLS
I8 aggreoate View
9 CIWPLS_WPN
& CIMPLS
& [CIvPLS
E Attachment Circuit Wiew
5 Ermulated Circuit view
E Aggregate View

Cancel

129279

Topology Tool

Choose the desired VPN's folder, select the folder, and click Open. This opens the desired folder to
display any logical and physical views associated with that VPN.

Click alogical or aphysical view iteminthefolder tree. Thelogical view minimizesthe amount of detail
and shows connectivity between customer devices. The physical view reveals more about the physical
structure of the VPN. For example, for MPLS it shows connectivity between customer and provider
devices and the core of the provider.

The Aggregate View, as shown in Figure 3-48, “Aggregate View,” shows connectivity between all
customer devices, regardless of the type of technology used to connect them.

A single view might show a combination of MPLS, Layer 2, and VPLS. For MPLS, only the Customer

Premises Equipment devices (CPES) are shown.

| oL-10727-01
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Figure 3-48 Aggregate View

# IP Solution Center - Topology Viewer [connected to wxyz-ull.cisco.com as admin] —OX
File Edit ¥iew Map Help
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B&d Site B Name

Customer flame
SPOKE

-----

o .
. - .

Site C Name |
Customer Mare 4

‘ HUE !

-
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B Site A Name
Customer Mame
SPOKE

[«]

L Provider Name: Region 1 Name LVPN—Name

111695

The Layer 2 VPN might in addition to CPES show connectivity between Customer Location Edge
devices (CLES) or Provider Edge devices (PE). For VPLS, you see connectivity between CPEs. For

missing CPEs, you see connectivity to PEs.

In MPLS Layer 2 VPN, the topology displays Virtual Circuit (VC) with MPLS core (as MPLS string)
but with L2TPv3, the topology will display Virtual Circuit (VC) with IP core (as IP string) as shown in

Figure 3-49.

] Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 3-49 Virtual Circuit with IP Core
%= IP Solution Center - Topology ¥iewer [connected to wxyz-uld cisco.camas admin] = |EI|1|
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VPLS Topology

In the case of aVPL Stopology, you can access an Attachment Circuit View or an Emulated Circuit View.
The Attachment Circuit View corresponds to alogical view in other types of VPNSs. It shows customer
devices connected to avirtual private LAN, as shown in Figure 3-50, “ Attachment Circuit View.”
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Figure 3-50 Attachment Circuit View
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The Emulated Circuit View shows the physical connectivity details omitted in the Attachment Circuit

View. Connectivity between provider devices and customer devices connected to provider devices, as
shown in Figure 3-51, “Emulated Circuit View.”

] Cisco IP Solution Center Infrastructure Reference, 4.2

oL-10727-01 |



| Chapter3

Service Inventory — Inventory and Connection Manager

Logical View

Step 1

Step 2

Step 3

Figure 3-51
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Thelogical view shows connectivity, created through service requests, between PEs and CPEs of agiven

region.

To activate the logical view, follow these steps:

In the menu bar, choose File > Open.

or
click the Open button in

the tool bar.

The Folder View window, as shown in Figure 3-47, appears.

Choose the desired VPN’s folder and double-click on the desired folder. Any logical and physical views
associated with that VPN are displayed.

To open the logical view for the selected VPN, do one of the following:

Single-click the L ogical View icon and click Open

or

Double-click the L ogical

View icon.

This creates alogical view for the chosen VPN, as shown in Figure 3-52.
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Figure 3-52 Logical View
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In acreated view, the node, usually located in the center of the graph, is the node representing a given
region of a provider. The node is annotated with the name of the region and the name of the provider.

Each node directly connected to the regional node represents a PE. The icon of a node depends on the
type and the role of the device it represents (see the “Conventions” section on page 3-40).

Each PE is annotated with the fully-qualified device name, provider name, region name, management | P
address, description, and role. A right-click on a node displays the details of the logical and physical
device, interfaces, and service requests (SR) associated with the node, as shown in Figure 3-53. For the
regional node, details are shown in atabulated form.

Figure 3-53 Device Properties

Logical Device...
Physical Device...
Interfaces...
Service Requests...

129113

The various node and link properties are described in detail in Viewing Device and Link Properties, page
3-55.

Likewise, you can right-click on alink to learn about its link properties. For example, when selecting
Interfaces... for a sample serial link, a Properties window like the one in Figure 3-54 appears.
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Figure 3-54 Interface Properties Window
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Each PE can belogically connected to one or more CPEs. Such connections are created by either MPLS
VPN links or Layer 2 Logical Links. Each such connection is represented by an edge linking the given
PE to a CPE. If there are more connections between a particular PE and CPE, all of them are shown.
Depending on the state of a connection, the edge is drawn using a solid line (for functioning
connections), dotted line (for broken connections), or dashed line (for connectionsyet to be established).

Depending on the connection type, the connection is drawn as described in Table 3-3 and Table 3-4.

Each connection isannotated with the PE I nterface Name (1P address), VLAN ID number, CPE Interface
Name (1P address).

In the Overview area, adirect connection is drawn between a CPE and a PE, even if anumber of devices
are forming such a connection.

For more about viewing device properties, see Viewing Device and Link Properties, page 3-55.

To view the details of a connection, right-click on it and select the Expand option from a pop-up menu.

The expanded view, displayed in a new tab, shows all devices and interfaces making a given PE to CPE
connection, as shown in Figure 3-55.
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Figure 3-55
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A physical view shows all named physical circuits defined for PEs in a given region. Each named

physical circuit is represented as a sequence of connections leading from a PE through its interfaces to
interfaces of CLEs or CPEs. All physical links between PEs of a given region and their CLEs or CPES
are shown. Since physical links are assumed to be in a perfect operational order, edges are always drawn

with solid lines.

To activate the physical view, follow these steps:

In the menu bar, choose File > Open.
or
click the Open button in the tool bar.

The Folder View window, as shown in Figure 3-47, appears.

Choose the desired VPN'’s folder and double-click on the desired folder. Any logical and physical views

associated with that VPN are displayed.
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Step3  To open the physical view for the selected VPN, do one of the following:
Single-click the Physical View icon and click Open
or

Double-click the Physical View icon.

This creates a physical view for the chosen VPN, as shown in Figure 3-56.

Figure 3-56 Physical View
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In this view, each device is connected with athin line to the interfaces it owns. Interfaces are connected

to other interfaces with thick lines. If there is more than one connection between two interfaces, they are
spaced to show all of them.

The tree shows devices and connections. Each device can be a folder, holding all interfaces connected
toit.

Viewing Device and Link Properties

In the logical view, you can view the properties of both devices and links. In the physical view, only
properties of physical devices are accessible.

Thus, device properties can be viewed in both the logical and physical views.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Device Properties

To view the properties of adevice, right-click the device. The Device Properties menu in Figure 3-57
appears.

Figure 3-57 Device Properties

Logical Device...
Physical Device...
Interfaces...
Service Requests...

129113

The following properties are available:

L ogical Device...—View the logical properties of the device.
Physical Device...—View the physical properties of the device.
Interfaces...—View interface properties of the device.

Service Requests...—View service request properties associated with the device.

Logical Device

When right-clicking a device and selecting L ogical Device..., the logical device properties window in
Figure 3-58 appears.

Figure 3-58 Logical Device Properties Window

% Properties... E x|
Propety | Value |

Device Mame device-a.domain.com

Provider Mame SBC

Region Mame ey York

Loopback Address

Raole Type M_FE

Close

129121

The logical properties window displays the following information:
Device Name—Name of the device.

Provider Name—Name of the provider whom the device is serving.
Region Name—Name of the provider region.

L oopback Address—IP address of the loopback address.

Role Type—Role assigned to the device.

] Cisco IP Solution Center Infrastructure Reference, 4.2
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When right-clicking adevice and selecting Physical Device..., the physical device propertieswindow in
Figure 3-59 appears.

Figure 3-59 Physical Device Properties Window
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The physical properties window displays the following information:

Name—Name of the device.

Description—User-defined description of the device.

Collection Zone—Collection zone for device data.

IP Address—IP address of the interface used in the topology.

User |D—User ID for the interface.

Enable User—Password for the interface.

Device Access Protocol—Protocol used to communicate with the device.

Config Upload/Download—Upload/download method for the configuration file.
SNMP Version—Simple Network Management Protocol (SNMP) version on the device.
Community String RO—public or private

Community String RW—public or private

SNMP Security L evel—Simple Network Management Protocol (SNMP) security level.
Authentication User Name—User name for performing authentication on the device.
Authentication Algorithm—Algorithm used to perform authentication.

Encryption Algorithm—Encryption algorithm used for secure communication.

| oL-10727-01
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Terminal Server—Name of the terminal server.

Terminal Server Port—Port number used by the terminal server.
Platform—Hardware platform.

Software—IOS version or other management software on the device.
Image Name—Boot image for device initialization.

Serial Number—Serial number of the device.

Interfaces

When right-clicking a device and selecting | nter faces..., the interface propertieswindow in Figure 3-60
appears.

Figure 3-60 Device Interface Properties Window
‘?:.-';Properties... : il
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Marme Ethernetdsn
IP Address 10.41.20 BB/24
IP Address Type STATIC
Encapsulation Ethernet
Description
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g
:
™

The interface properties window displays the following information:
Name—Name of the device.

I P Address—IP address of the device.

IP Address Type—STATIC or DYNAMIC.
Encapsulation—Encapsulation used on the interface traffic.
Description—Description assigned to the interface, if any.

Select (link)—If a connection is attached to the interface, a drop-down list at the bottom of the window
allows you to choose between the interfaces available on the device.

Service Requests

When right-clicking a device and selecting Service Requests..., the service request (SR) properties
window in Figure 3-61 appears.
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Figure 3-61 Service Request Properties Window
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The service request properties window displays the following information:
Job | D—SR identifier.

Type—Protocol type used in the SR.

State—SR state.

Operation Type—Encapsulation used on the interface traffic.
Creator—Description assigned to the interface, if any.

Creation Time—Date and time when the SR was created.

Customer Name—Name of customer associated with the SR.

Last Modified—Date and time when the SR was last modified.
Description—User-defined description of the SR.

Select (SR)—If more than one SR is associated with the interface, the drop-down list at the bottom of
the window allows you to choose between these SRs.

To view the properties of agiven link, right-click the link. The Link Properties menu in Figure 3-62
appears.

Figure 3-62 Link Properties

Expand...

Senvice Request...
MPLS VYPH LinK...

129119

The following options are available:
Expand...—View link details, including devices local to the link not shown in the general topology.
Service Request...—View service request properties associated with the link.

MPLSVPN...—View the MPLS VPN properties of the link. Other link protocol propertiesthan MPLS
VPN are currently not available.

| oL-10727-01
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Expand

When right-clicking alink and selecting Expand..., the Topology Display will display any devices and
connections local to that link. An Expand Link window similar to the one in Figure 3-63 will appear.

Figure 3-63 Expand Link Window

: Name contains: |

Advanced...

& sp-edge-7

inu-telecom
iou-telecam
192 162.100.17
sp-edye-7
M-FE

-

w2 Serial6/0

192 169.34.2/30
HDLE

i Serial1/0

192.169.34.1/30
HOLEG

cust-edge-T-6
@

ese-vpn-sp-eust
csc-vpn-sp-custsite-2
182,169 .34.1
cust-edge-7-6

[4]

L ioy-telecom: iou-telecom L sp-edge-7 - cust-edge-7-6 |

[ »

129114

Propertiesinformation for devices and links can only be obtained in the master view as described earlier
in this section.

Service Request

When right-clicking alink and selecting Service Requests..., the service request (SR) properties
window in Figure 3-64 appears.
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Figure 3-64 Link Service Request Properties Window
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The service request properties window displays the following information:
Job ID—SR identifier.

Type—Protocol type used in the SR.

State—SR state.

Operation Type—Encapsulation used on the interface traffic.

Creator—Description assigned to the interface, if any.

Creation Time—Date and time when the SR was created.

Customer Name—Name of customer associated with the SR.

Last Modified—Date and time when the SR was last modified.

Description—User-defined description of the SR.

Select (SR)—If more than one SR is associated with the interface, the drop-down list at the bottom of
the window allows you to choose between these SRs.

MPLS VPN

When right-clicking alink that is configured for MPLS VPN and selecting MPLS VPN..., the MPLS
VPN properties window in Figure 3-65 appears.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 3-65 Link MPLS VPN Properties Window
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The service request properties window displays the following information:
Status—Status of the MPLS VPN link.

Status M essage—Displays any error or warning messages.

Operation Type—MPLS operation type.

Policy Type—The policy type applied to the link.

Data MTD Threshold—Memory Technology Driver (MTD) data threshold.
Default MTD Address—Default MTD |IP address.

Data MTD Subnet—Data MTD subnet.

Data MTD Size—DataMTD size.

SOO Enabled—Yes or No.

Manual Config—Yesor No.

Filtering and Searching

On large graphs, the amount of detail can be overwhelming. In such cases, filtering might help eliminate

unnecessary details, while searching can lead to a prompt location of a device you want to examine
further.

Both advanced filtering and searching use the same dialog to enter conditions on nodes to be either
filtered or located. The filtering area also allows you to quickly filter viewed objects by name.

Filtering
The topology view can be filtered in two ways, simple and advanced.
Simple Filtering

To perform simple filtering of the view, follow these steps:

Stepl  Enter astring in area (4) of the main window, as shown in Figure 3-44 on page 3-44.
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Press Enter to dim all objects whose name does not contain the specified string.

For example, to locate nodes that contain string router in their name you would enter router in area (4)
and click Enter. All objects whose name does not contain the entered string are dimmed, as shown in
Figure 3-66.

Figure 3-66 Physical View with Dimmed Nodes
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Note  Regular expressions are supported but only in the advanced dialog (click Advanced... button).

For example, by entering ~f00.*a, you only request nodes that have names starting with "foo"
followed by arbitrary characters and containing the letter 'a somewherein the name. The regular
expressions must follow the rules defined for Java regular expressions.

To perform advanced filtering, follow these steps:

Open the advanced filtering dialog by clicking the Advanced... button. The Advanced Filter dialog
appears, as shown in Figure 3-67.

| oL-10727-01
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Step 2

Make the desired filtering elections.

The dialog allows you to enter one or more conditions on filtered nodes. The first drop-down list allows
you to specify the attribute by which the filtering is performed. The second allows you to decide how the
matching between the value of the attribute and text entered in the third column is performed.

The following matching modes are supported from the drop-down list:

« contains—The attribute value is fetched from the device and it is selected if it contains the string
given by you. The string can be located at the start, end, or middle of the attribute for the match to
succeed. For example, if the pattern isclethe following values match it in the contains mode: clean,
nucleus, circle.

» startswith—The value of the attribute must start with the string given by you. For example, if the
pattern is foot, footwor k matches, but afoot does not.

« endswith—Thisisthe reverse of the starts with case, when a given attribute matches only if the
specified pattern is at the end of the attribute value. In this mode, for example, the pattern foot
matches afoot but not footwork.

- doesn't contain—In this mode, only those strings that do not contain the given pattern match. The
results are opposite to that of the contains mode. For example, if you specify cleinthismode, clean,
nucleus, and circle are rejected, but foot is deemed to match, because it does not contain cle.

- matches—Thisisthe most generic mode, in which you can specify afull or partial expression that
defines which nodes you are interested in.

Figure 3-67 Advanced Filter Dialog
% Filter... x|
'®) Match any conditions ' Match all conditions
|Name - | |cuntains - | |ruuter |
| Name v| |[startswith | [193 |
| More | | Fewer [_] match case
| ok | cancel | clear | %
o

By clicking one of the two radio buttons, Match any conditions or Match all conditions, you can
request that any or all of the conditions are matched. In the first case, you can look for devices where,
for example, the name contains cisco and the management | P address endswith 204. When all conditions
must be met, it is possible to look for devices that, for example, have a given name and platform.

Click More or Fewer to add more rows of conditions or remove existing rows of conditions.

By default, all matches are performed without regard for upper or lower case. However, in some cases it
is beneficial to have a more exact matching that takes the case into account. To do so, check the Match
case check box.
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Step3  Click OK to start thefiltering process. Click Cancel to hide the dialog without any changes to the state
of the filters.

The Clear button allowsyou to clear all conditions. Clicking Clear followed by OK effectively removes
all filtering, restoring all nodes to their default brightness level. If filtering is active, the same can be
achieved by clicking Clear in area (4) of the main window, as shown in Figure 3-44 on page 3-44.

Searching

Searching can be conducted by using the menus or the tool bar. To perform a search, follow these steps:

Stepl  Select Find in the Edit menu
or
Click the Find icon in the main toolbar.
Both approaches bring up the same dialog box, as shown in Figure 3-68.
Again, you can enter one or more conditions to locate the node.

Figure 3-68 Find Dialog Box
X
i@ Match any conditions ) Match all conditions
Name - | |[:urrtains - | [routed |

More [_] Match case

OK ” Cancel || Clear

Q3692

Step2  Make the desired filtering selections. Match modes, case check box, and the radio button are used as
described under Advanced Filtering, page 3-63, as shown in Figure 3-67.

Step3  Click OK to start searching for the first node that matches the given criteria. If found, the node is
highlighted and the view is shifted to make it appear in the currently viewed area of the main window.

Step4  After thefirst search, press F3 or click the Find Again button to repeat the search. If more than one node
matches the condition the Find Again function highlights each one of them. If no nodes match the
entered criteria, the Object Not Found dialog box appears.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Using Maps

You can associate a map with each view. Currently, the topology viewer only supports maps in the
Environmental Systems Research Institute, Inc. (ESRI) shape format. The following sections describe
how to load maps and selectively view map layers and data associated with each map.

The map features are accessed from the Map menu shown in Figure 3-69.

Figure 3-69
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The Map menu contains the following menu items:

« Open Map... Loads a map into the application

« Clear Map Clears the active map from the current view

« View Allowsyou to select which layersin the map should be displayed (for example, country, state,

city).

] Cisco IP Solution Center Infrastructure Reference, 4.2
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Loading a map

Step 1

Step 2

Step 3

You might want to set a background map showing the physical locations of the displayed devices. To

load a map, follow these steps:

In the menu bar, select Map > Open Map....

Topology Tool

or
Press Ctrl-M
Providing the web map server is running and operational, the Load Map window appears, as shown in
Figure 3-70.
Figure 3-70 Load Map Window
B leadMap _________JEyupL
Looici: |2 - @6 ok
Ij Asia Projection
[ Europe | Mercator - |
[ Morth_America
3 Oceania Longitude Range
I South_America | _mol::i | 130|:,=1
CJ world
Latitude Range
_enled [=]
| -soH| o
File Name: || |
Files of Type: | All Files v|
Open || cancel |

Make your selections in the Load Map window.

111702

The right-hand side of the window contains a small control panel, which allows you to select the
projection in which a map is shown. A map projection is a projection that maps a sphere onto a plane.
Typical projections are Mercator, Lambert, and Stereographic.

For more information on projections, consult the Map Projections section of Eric Weisstein's World of

Mathematics at:

http://mathworld.wolfram.com/topics/M apPr oj ections.html

For each projection, you can also select the region of the map to be shown. In most cases, the predefined
values should be sufficient. The top level the file hierarchy should contain folders for all major regions,
such as Europe, North America, Oceania, and so on.

If desired, make changes to the settings in the L ongitude Range and L atitude Range fields.

Choose the desired folder.

Each folder can contain either complete maps or folders for countries. Each map is clearly distinguished

with the Map icon.

| oL-10727-01
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Step4  Select amap file and click Open to load the map.

Selecting the map file and clicking the Open button starts loading it. Maps can consist of several
components and thus a progress dialog is shown informing you which part of the map file is loaded.

Layers

Each map can contain several layers. For example most country maps have country, region, and city
layers, as shown in Figure 3-71.
Figure 3-71 Map Layers
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After amap isloaded, the View submenu of the M ap menu is automatically populated for you. A name
of each available layer is shown together with the check box indicating visibility of the layer. If agiven
map shows too many details, you can turn off some or all layers by unchecking the corresponding check
box(es). The same submenu can be used to restore visibility of layers.

If an incorrect map is loaded or the performance of the topology tool is unsatisfactory with the map

loaded, you can clear the map entirely. To do this, select Clear Map from the Map menu. Maps are
automatically cleared if another map is |oaded.

Consequently if you want just to load another map, there is no need to clear the existing map. The act of
loading a new map does this.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Map data

Topology Tool

If map data files are successfully loaded with the map, the right field of the Status bar shows the
longitude and latitude location of the cursor on the map. If map objects, such as cities, lakes, and so on,
have data associated with them, their names are displayed after the longitude and latitude coordinates.

Node locations

After amap is successfully loaded, the view area is adjusted to fully accommodate it, as shown in
Figure 3-72. If nodes shown on the window had longitude and | atitude information associated with them,
they are moved to locations on the map corresponding to their geographical location. If not, their

positions remain unchanged.

However, you can manually move them to the desired location and save the positions for future
reference. The next time the image of agiven network isloaded, node positions are restored and the map

fileisloaded.

Figure 3-72
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Adding new maps

You might want to add your own maps to the selection of maps available to the topology application.
Thisis done by placing a map file in the desired directory within the |SC installation. To make this
example more accessible, assume that you want to add a map of Toowong, a suburb of Brisbane, the
capital of Queensland. Thefirst step to do so is to obtain maps from a map vendor. All maps must bein
the ESRI shape file format (as explained at the web site: http://www.esri.com). In addition, a datafile
might accompany each shape file. Data files contain information about objects whose shapes are
contained within the shape file. Let us assume that the vendor provided four files:

- toowong_city.shp
- toowong_city.dbf
- toowong_street.shp
» toowong_street.dbf

We must create a map file that informs the topol ogy application about layers of the map. In this case we
havetwo layers: acity and astreet layer. The map file, say, Toowong.map, would thus have the following
contents:

toowong_city
toowong street

It lists all layers that create a map of Toowong. The order isimportant, as the first file forms the
background layer, with other layers placed on top of the preceding layers.

Having obtained shape and data files and having written the map file, decide on itslocation. As
mentioned, Toowong is a suburb of Brishane, located in Queensland, Australia. All map files must be
located in or under the $I SC_HOM E/resour ces/webser ver /tomcat/webapps/ipsc-maps/data
directory. Since by default this directory contains adirectory called Oceania intended for all maps from
that region, simply create a path Australia/Queensland/Brisbane under the directory Oceania. Next,
place all fivefilesin thislocation. After thisis done, the map is automatically accessible to the topol ogy
viewer.

Devices

Every network element that |SC manages must be defined as a device in the system. An element is any
device from which I SC can collect information. In most cases, devices are Cisco |0S routers that
function as Provider Edge Routers (PEs) or Customer Edge Routers (CES) in the MPLS VPN.

Note  To provision services with ISC, you must have |Pv4 connectivity.

This section describes how to configure SSH, set up SNMP, manually enable an RTR responder, and
create, edit, delete, and configure various types of supported devices. This section includes the
following:

- Configuring SSH, page 3-71

» Setting Up SNMP, page 3-72

« Manually Enabling RTR Responder on Cisco |OS Routers, page 3-74
« Accessing the Devices Window, page 3-74

» Creating a Device, page 3-76

Cisco IP Solution Center Infrastructure Reference, 4.2
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» Editing a Device, page 3-93

» Deleting Devices, page 3-96

- Editing a Device Configuration, page 3-97
« E-mailing a Device’'s Owner, page 3-99

« Copying a Device, page 3-100

Configuring SSH

Devices I

I SC needs a mechanism to securely access and deploy configuration files on devices, which include
routers and switches. And, to securely download a configlet and upload a configuration file from a

device, SSH must be enabled.

The following sections describe how to configure SSH on a device.

Configuring SSH on Cisco I0S Routers

Step 1
Step 2

Step 3

Step 4
Step 5

Step 6
Step 7

Step 8

Step 9
Step 10

This Cisco |OS router configuration procedure assumesthat the router’ s authentication database is stored
locally on the router and not on a TACACS or RADIUS server.

The procedure for configuring SSH on a Cisco 10S router is as follows..

Command

Description

Router# configure terminal

Enters global configuration mode.

Router (config)# ip domain-name
<domain namex>

Specifies the IP domain name.

Router (config)# username <username>
password <passwords>

Configures the user ID and password. Enter your
I SC username and password. For example:

username admin password iscpwd

Router (config)# crypto key generate rsa

Generates keys for the SSH session.

You will see the following prompt:

Choose the size of the key modulus in the
range of 360 to 2048 for your general
purpose keys. How many bits in the modulus
(nnn) :

Press Enter to accept the default number of bits.

Sets the number of bits.

Router (config)# line vty 0 4

Enables SSH as part of the vty login transport.

Router (config-line)# login local

The login local command indicates that the router
stores the authentication information locally.

Router (config-line)# transport input
telnet ssh

Enables SSH transport.

Router (config-line)# Ctrl+Zz

Returns to Privileged Exec mode.

Router# copy running startup

Saves the configuration changes to NVRAM.

| oL-10727-01
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Setting Up SNMP

To work with ISC, SNMP must be configured on each CPE device in the customer network. In ISC,
SNMP is used to:

« collect from the Interface MIB
» provision and collect SLA data.

Two security models are available: SNM Pv1/v2c and SNMPv3. Table 3-5 identifies the combinations of
security models and levels.

Table 3-5 SNMP Security Models and Levels
Model Level Authentication |Encryption Description
vl/v2c No Authentication/ |Community No Uses a community string match
No Encryption String for authentication.
v3 No Authentication/ |Username No Uses a username match for
No Encryption authentication.
v3 Authentication/ MD5or SHA |No Provides authentication based on
No Encryption the HMAC-MD5 or
HMAC-SHA algorithms,
v3 Authentication/ MD5or SHA |DES Providesauthentication based on
Encryption the HMAC-MD5 or
HMAC-SHA algorithms, and
provides DES 56-bit encryption
in addition to authentication
based on the CBC-DES
(DES-56) standard.

SNMPv3 provides for both security models and security levels. A security model is an authentication
strategy that is set up for a user and the group in which the user resides. A security level isthe permitted
level of security within a security model. A combination of a security model and a security level
determines which security mechanism is employed when handling an SNMP packet.

The security features provided in SNMPv3 are as follows:
- Message integrity—Ensures that a packet has not been tampered with in-transit.
» Authentication—Determines the message is from a valid source.

e Encryption—Encoding the contents of a packet to prevent it from being read by an unauthorized
source.

SNMPv3 objects have the following characteristics:
« Each user belongs to a group.

< The group defines the access policy for a set of users and determines the list of notifications its users
can receive. The group also defines the security model and security level for its users.

» The access policy defines which SNMP objects can be accessed for reading, writing, or creation.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Setting Up SNMPv1/v2c on Cisco 10S Routers

Step 1

Step 2

Step 3
Step 4

Step 5

Step 6
Step 7

Je

Tip

Devices I

To determine whether SNMP is enabled, and to set the SNM P community strings on a Cisco | OS router,

perform the following steps for each router:

Command

Description

Router> enable
Router> <enable password>

Enters enable mode, and then enters the enable
password.

Router# show snmp

Check the output of the show snmp command
to see whether the following statement is
present: “sNMP agent not enabled.” If SNMP
is not enabled, complete the stepsin this
procedure.

Router# configure terminal

Enters global configuration mode.

Router (config)# snmp-server community
<userstring> RO

Sets the community read-only string.

Router (config)# snmp-server community
<userstring> RW

Sets the community read-write string.

Router (config)# Ctrl+z

Returns to Privileged Exec mode.

Router# copy running startup

Saves the configuration changes to NVRAM.

The SNMP community strings defined in | SC for each target device must beidentical to those configured

on the device.

Setting SNMPv3 Parameters on Cisco I10S Routers

Je

Tip

Note

Step 1

Step 2

This section describes how to set the SNMPv3 parameters on Cisco 10S routers. SNMPv3 is only
supported on 10S crypto images. For Authentication/Encryption, the |OS image must have DES56.

The SNMP users defined in I|SC for each target device must be identical to those configured on the

device.

To check the existing SNMP configuration, use these commands in the router terminal session:

®* show snmp group

®* show snmp user

To set the SNMPv3 server group and user parameters on a Cisco 10S router, perform the following steps.

The group must be created first and then the user.

Command

Description

Router> enable
Router> <enable password>

Enters enable mode, then enter the enable
password.

Router# configure terminal

Enters global configuration mode.

| oL-10727-01
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Step 3

Step 4

Step 5
Step 6

Command

Description

Router (config)# snmp-server group
[<groupname> {vl | v2c | v3 {auth | noauth |
priv}}] [read <readviews>] [write
<writeview>] [notify <notifyviews]

[access <access-1ist>]

Thesnmp-server group command configuresa
new SNMP group or atable that maps SNMP
users to SNMP views. Each group belongsto a
specific security level.

Exanuﬁeisnmp—server group v3auth v3 auth

read vldefault write vldefault

Router (config)# snmp-server user <username>
[<groupname> remote <ip-addressx>

[udp-port <port>] {vl | v2ec | v3 [encrypted]
[auth {md5 | sha} <auth-password> [priv
des56 <priv-passwords>]]

[access <access-1ist>]

The snmp-server user command configures a
new user to an SNMP group.

Exanwﬂeisnmp-server user userl v3auth v3

auth md5 userlPass

Router (config)# Ctrl+z

Returns to Privileged Exec mode.

Router# copy running startup

Saves the configuration changes to NVRAM.

Manually Enabling RTR Responder on Cisco 10S Routers

~

Note

Step 1

Step 2
Step 3

Step 4
Step 5

SNMP must be configured on the router.

To manually enable an RTR Responder on a Cisco 10S router, execute the following steps:

Command

Description

Router> enable
Router> <enable password>

Enters enable mode, and then enters the enable
password.

Router# configure terminal

Enters the global configuration mode.

Router (config)# rtr responder

Enablesthe SA responder on the target router of
SA Agent operations.

Router (config)# Ctrl+z

Returns to Privileged Exec mode.

Router# copy running startup

Saves the configuration changes to NVRAM.

Accessing the Devices Window

Step 1

The Devices feature is used to create, edit, delete, and configure devices, and e-mail the device owner.

To access the Devices window, follow these steps:

Choose Service Inventory > Inventory and Connection Manager > Devices to access the Devices

window shown in Figure 3-73.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Devices M
Figure 3-73 Devices List Window
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The Devices window contains the following:

« Device Name Lists the fully qualified host and domain name of the device. You can sort the list of
devices by device name.

- Management | P Address Liststhe management | P address or the IE2100 address. You can sort the
list of devices by thisfield.

- TypelListsthetype of the device. Typesinclude: Cisco |OS Device, CatOs Device, Terminal Server,
and 1E2100.

« Parent Device Name

In the Devices window, you can create, edit, delete, or configure devices, e-mail the device owner, or
copy using the following buttons:

» Create Click to create new devices. Enabled only if no devices are selected.

« Edit Click to edit selected device (select device by checking the corresponding box). Enabled only
if asingle deviceis selected.

- Delete Click to delete selected device (select device by checking the corresponding box). Enabled
only if one or more devices are selected.

» Config Click to change the selected device configuration (select device by checking the
corresponding box). Enabled only if a single device is selected.

- E-mail Click to send e-mail to the owner of the selected device(s) (select device(s) by checking the
corresponding box(es)). Enabled only if one or more devices are selected.

« Copy Click to copy selected device (select device by checking the corresponding box). Enabled only
if asingle deviceis selected.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Creating a Device

From the Create window, you can define different types of devices.

To create a device, follow these steps:

Stepl  Choose Service Inventory > Inventory and Connection Manager > Devices.

Step2  Click the Create button.

The Create options window appears, as shown in Figure 3-74.

Figure 3-74
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The Create options include the following:

- Catalyst Switch A Catalyst device running the Catalyst Operating System.

« Cisco Device Any router that runsthe Cisco 10S. Thisincludes Catalyst devicesrunning Cisco |OS.

- Terminal Server A devicethat representsthe workstation that can be used to provision edge routers.

« |E2100 Any Cisco Intelligence Engine (IE) 2100 series network device.
Step3  Seethe following sections for instructions on creating each type of device.

» Creating a Catalyst Switch, page 3-77

» Creating a Cisco Device, page 3-81

» Creating a Terminal Server, page 3-87
» Creating a Cisco CNS |E2100, page 3-92
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Creating a Catalyst Switch

Step 1
Step 2
Step 3

To create a Catalyst switch, follow these steps:

Devices I

Choose Service Inventory > Inventory and Connection Manager > Devices.

Click the Create button.
Select Catalyst Switch.

The Create Catalyst Device window appears, as shown in Figure 3-75.

Figure 3-75 Create Catalyst Device Window
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The General section of the Create Catalyst Device window contains the following fields:

Device Host Name (required) Must begin with aletter, digit, or underscore followed by letters,
digits, underscores, spaces, hyphens, or dots ending with a letter, digit, or underscore. Thisfield
must match the name configured on the target router device. Limited to 256 characters.

Device Domain Name (optional) Must begin with aletter, digit, or underscore followed by letters,
digits, underscores, spaces, hyphens, or dots ending with aletter, digit, or underscore. The name
must match the domain name on the target router device.

Description (optional) Limited to 80 characters. Can contain any pertinent information about the
device such as the type of device, itslocation, or other information that might be helpful to service
provider operators.

Collection Zone (optional) Drop-down list of all collection zones within the ISC. Choicesinclude;
None and al collection zones within the ISC. Default: None.

Management | P Address (optional) Valid | P address of the device that ISC uses to configure the
target router device.

Interfaces (optional) Click the Edit button to view, add, edit, and delete all interfaces associated
with the device. See Table 3-6 for a description of the Interfaces fields.

Table 3-6 Create Catalyst Device Interfaces Fields

Field Description Additional

Name Name of thisinterface. List can be sorted by thisfield.

Limited to 80 characters.

Encapsulation The Layer 2 Encapsulation for | DEFAULT

this device. DOT1Q
ETHERNET

ISL
FRAME_RELAY
FRAME_RELAY _IETF
HDLC

PPP

ATM
AAL5SNAP
AALO

AALS
AAL5MUX
AALSNLPID
AAL2
ENCAP_QinQ
GRE

IP Address I P address associated with this

interface.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Table 3-6 Create Catalyst Device Interfaces Fields (continued)
Field Description Additional
Port Type NONE
ACCESS
TRUNK
ROUTED
VLAN ID The VLAN ID to assign to this
interface.

Associated Groups (optional) Click the Edit button to view, add, and remove all Device Group
associations.

Operating System (optional) Click the radio button for the operating system currently running on
the CAT switch. Choicesinclude: Catalyst OS or Cisco 10S. Default: Catalyst OS. When you choose
the 10S operating system, VPNSM is available under the heading Catalyst Properties. If you click
the Edit button for VPNSM, you can Create, Edit, and Delete VPN Service Modules (VPNSMs).

The Login and Password Information section of the Create Catalyst Device window contains the
following fields:

L ogin User (optional) Not required by ISC. However, collection and upload/download will not
function without the Login User and Login Password as ISC will not be able to access the device.
Should match what is configured on the target router device. Limited to 80 characters.

L ogin Password (optional) Not required by | SC. However, collection and upl oad/download will not
function without the Login User and Login Password, because ISC will not be able to access the
device. Should match what is configured on the target router device. Limited to 80 characters.

Verify Login Password (optional) Must match the Login Password field. Limited to 80 characters.

Enable User (optional) Not required by ISC. However, collection and upload/download only
function if the Login User has sufficient privileges to configure the router in EXEC mode. Should
match what is configured on the target router device. Limited to 80 characters.

Enable Password (optional) Not required by 1SC. However, collection and upload/download only
function if the Login User has sufficient privileges to configure the router in EXEC mode. Should
match what is configured on the target router device. Limited to 80 characters.

Verify Enable Password (optional) Must match the Enable Password field. Limited to 80
characters.

The Device and Configuration Access Information section of the Create Catalyst Device window
contains the following fields:

Terminal Session Protocol (optional) Configures the method of communication between 1SC and
the device. Choicesinclude: Telnet, Secure Shell (SSH), and CNS. In previous versions of | SC, this
field was called the Transport field. Default: The default set in the DCPL properties.

Config Access Protocol (optional) Administersthe access protocol for config upload and downl oad.
Choicesinclude: Terminal, TFTP, and FTP. Default: The default set in the DCPL properties.

SNMP Version (optional) Configures the version of SNMP to use when communicating with the
device. Choices include: SNMP v1/v2c and SNMP v3. Default: The default set in the DCPL
properties.

| oL-10727-01
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Step 4
Step 5

The SNMP v1/v2c section of the Create Catalyst Device window contains the following fields:

Community String RO (optional) SNM P Read-Only Community String. Many tasks use SNMP to
access the device. This field must match what is configured on the target router device. Limited to
80 characters.

Community String RW (optional) SNMP Read-Write Community String. Many tasks use SNMP
to access the device. This field must match what is configured on the target router device. Limited
to 80 characters.

Enter the desired information for the Catalyst device you are creating.

To access the Additional Properties section of the Create Catalyst Device, click Show.

The Additional Properties window appears, as shown in Figure 3-76.

Figure 3-76 Catalyst Device Additional Properties Window
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The SNMP v3 section of the Catalyst Device Properties window contains the following fields:

SNMP Security L evel (optional) Choices include: Default (<default_set in_ DCPL>),
Authentication/No Encryption, and Authentication/Encryption. Default: Default
(<default_set_in_DCPL>). Note: When you change the DCPL property, the
<default_set_in_DCPL> variable changes.

Authentication User Name (optional) User name configured on the specified device router. User
must have permission to the object identification numbers (OIDs) specified in the security request
(that is, write permission for aset request, and read permission for aget request). Should match what
is configured on the target router device. Should be provisioned if the SNMP Security Level is
Authentication/No Encryption or Authentication/Encryption. Limited to 80 characters.
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Authentication Password (optional) Should be provisioned if the SNMP Security Level is
Authentication/No Encryption or Authentication/Encryption. Should match what is configured on
the target router device. Limited to 80 characters.

Verify Authentication Password (optional) Must match the Encryption Password field. Limited to
80 characters.

Authentication Algorithm (optional) Should be provisioned if the SNMP Security Level is
Authentication/No Encryption or Authentication/Encryption. Choices include: None, MD5, and
SHA. Default: None.

Encryption Password (optional) In previous versions of 1SC, this field was called Privacy
Password. Should match what is configured on the target router device. Should be provisioned if the
SNMP Security Level is Authentication/Encryption. Limited to 80 characters.

Verify Encryption Password (optional) Must match the Encryption Password field. Limited to 80
characters.

Encryption Algorithm (optional) In previous versions of 1SC, this field was called Privacy
Protocol. Should be provisioned if the SNMP Security Level is Authentication/Encryption. Choices
include: None and DES 56. Default: None.

The Terminal Server Options section of the Catalyst Device Properties window contains the following
fields:

Terminal Server (optional) Choicesinclude: None and the list of existing Terminal Server names.
Default: None.

Port (optional) Disabled until a Terminal Server is selected. Range: 0-65535. Default: 0.

The Device Platform Information section of the Catalyst Device Properties window contains the
following fields:

Platform (optional) Should match what is configured on the target router device. Limited to 80
characters.

Softwar e Version (optional) Should match what is configured on the target router device. Limited
to 80 characters.

I mage Name (optional) Should match what is configured on the target router device. Limited to 80
characters.

Serial Number (optional) Should match what is configured on the target router device. Limited to
80 characters.

Device Owner’s Email Address (optional) Used in the To: field when the Email button is selected
from the device list. Limited to 80 characters and must be valid Email format.

Step6  Enter any desired Additional Properties information for the Catalyst device you are creating.
Step7  Click Save.
The Devices window reappears with the new Catalyst device listed.

Creating a Cisco Device

To create a Cisco device, follow these steps:

Stepl  Choose Service Inventory > Inventory and Connection Manager > Devices.
Step2  Click the Create button.

| oL-10727-01
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Step 3

Select Cisco Device.

Figure 3-77 Create Cisco Device Window
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The Create Cisco Device window appears, as shown in Figure 3-77.
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The General section of the Create Cisco 10S Device window contains the following fields:

- Device Host Name Must begin with aletter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with aletter, digit, or underscore. Thisfield isrequired
and must match the name configured on the target router device. Limited to 256 characters.

- Device Domain Name (optional) Must begin with aletter, digit, or underscore followed by letters,
digits, underscores, spaces, hyphens, or dots ending with aletter, digit, or underscore. The name
must match the domain name on the target router device.

» Description (optional) Limited to 80 characters. Can contain any pertinent information about the
device such as the type of device, itslocation, or other information that might be helpful to service
provider operators.

« Collection Zone (optional) Drop-down list of all collection zones within the ISC. Choices include:
None and all collection zones within the ISC. Default: None.

« Management | P Address (optional) Valid IP address of the device that | SC uses to configure the
target router device.

- Interfaces (optional) Click the Edit button to view, add, edit, and delete all interfaces associated
with the device. See Table 3-7 for a description of the Interface fields.

Table 3-7 Create Cisco Device Interface Fields

Field Description Additional

Name Name of thisinterface. List can be sorted by thisfield.
Limited to 80 characters.

Encapsulation The Layer 2 Encapsulation for | DEFAULT

this device. DOT1Q

ETHERNET
ISL
FRAME_RELAY
FRAME_RELAY_IETF
HDLC
PPP
ATM
AALSSNAP
AALO
AALS
AAL5MUX
AALSNLPID
AAL2
ENCAP_QinQ
GRE

IP Address IP address associated with this

interface.
Cisco IP Solution Center Infrastructure Reference, 4.2
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Associated Groups (optional) Click the Edit button to view, add, and remove all Device Group
associations.

The Login and Password Information section of the Create Cisco 10S Device window contains the
following fields:

Login User (optional) Not required by I SC. However, collection and upload/download will not
function without the Login User and Login Password as |SC will not be able to access the device.
Should match what is configured on the target router device. Limited to 80 characters.

L ogin Password (optional) Displayed as stars (*). Not required by | SC. However, collection and
upload/download will not function without the Login User and L ogin Password as 1SC will not be
able to access the device. Should match what is configured on the target router device. Limited to
80 characters.

Verify Login Password (optional) Displayed as stars (*). Must match the Login Password field.
Limited to 80 characters.

Enable User (optional) Not required by 1SC. However, collection and upload/download only
function if the Login User has sufficient privileges to configure the router in EXEC mode. Should
match what is configured on the target router device. Limited to 80 characters.

Enable Password (optional) Displayed as stars (*). Not required by | SC. However, collection and
upload/download only function if the Login User has sufficient privileges to configure the router in
EXEC mode. Should match what is configured on the target router device. Limited to 80 characters.

Verify Enable Password (optional) Displayed as stars (*). Must match the Enable Password field.
Limited to 80 characters.

The Device and Configuration Access Information section of the Create Cisco 10S Device window
contains the following fields:

Terminal Session Protocol (optional) Configures the method of communication between ISC and
the device. Choicesinclude: Telnet, Secure Shell (SSH), and CNS. In previous versions of ISC this

Config Access Protocol (optional) Administersthe access protocol for config upload and download.
Choicesinclude: Terminal, TFTP, and FTP. Default: The default set in the DCPL properties.

SNMP Version (optional) Configures the version of SNMP to use when communicating with the
device. Choices include: SNMP v1/v2c and SNMP v3. Default: The default set in the DCPL
properties.

The SNMP v1/v2c section of the Create Cisco |0S Device window contains the following fields:

Community String RO (optional) SNM P Read-Only Community String. Many tasks use SNMP to
access the device. This field must match what is configured on the target router device. Limited to
80 characters.

Community String RW (optional) SNMP Read-Write Community String. Many tasks use SNMP
to access the device. This field must match what is configured on the target router device. Limited
to 80 characters.

Step4  Enter the desired information for the Cisco 10S device you are creating.

Step5  To access the Additional Properties section of the Create Cisco Device, click Show.

The Additional Properties window appears, as shown in Figure 3-78.
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Figure 3-78 Cisco Device Properties Window
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Device Platform Information

Platform:

Software Version:

Image Marne:
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| Save | Cancel
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The SNMP v3 section of the Cisco |0S Device Properties window contains the following fields:

« SNMP Security Level (optional) Choicesinclude: Default (<default_set_in_DCPL>),
Authentication/No Encryption, and Authentication/Encryption. Default: Default
(<default_set_in_DCPL>). Note: When you change the DCPL property, the
<default_set_in_ DCPL> variable changes.

- Authentication User Name (optional) User name configured on the specified device router. User
must have permission to the object identification numbers (OIDs) specified in the security request
(that is, write permission for aset request, and read permission for aget request). Should match what
is configured on the target router device. Should be provisioned if the SNMP Security Level is
Authentication/No Encryption or Authentication/Encryption. Limited to 80 characters.

| oL-10727-01
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Authentication Password (optional) Displayed as stars (*). Should be provisioned if the SNMP
Security Level is Authentication/No Encryption or Authentication/Encryption. Should match what
is configured on the target router device. Limited to 80 characters.

Verify Authentication Password (optional) Displayed as stars (*). Must match the Encryption
Password field. Limited to 80 characters.

Authentication Algorithm (optional) Should be provisioned if the SNMP Security Level is
Authentication/No Encryption or Authentication/Encryption. Choices include: None, MD5, and
SHA. Default: None.

Encryption Password (optional) Displayed as stars (*). In previous versions of 1SC, thisfield was
called Privacy Password. Should match what is configured on the target router device. Should be
provisioned if the SNMP Security Level is Authentication/Encryption. Limited to 80 characters.

Verify Encryption Password (optional) Displayed as stars (*). Must match the Encryption
Password field. Limited to 80 characters.

Encryption Algorithm (optional) In previous versions of 1SC, this field was called Privacy
Protocol. Should be provisioned if the SNMP Security Level is Authentication/Encryption. Choices
include: None and DES 56. Default: None.

The Terminal Server and CNS Options section of the Cisco 10S Device Properties window contains the
following fields:

Terminal Server (optional) Choicesinclude: None and the list of existing Terminal Server names.
Default: None.

Port (optional) Disabled until a Terminal Server is selected. Range: 0-65535. Default: 0.

Fully Managed (optional) If the Fully Managed check box is checked, the device becomes a fully
managed device. ISC performs additional management actions only for fully managed devices.
These actions include e-mail notifications upon receipt of device configuration changes originated
outside ISC and the scheduling of enforcement audit tasks upon detection of possible intrusion.
Default: Not selected and therefore not selected.

Device State (optional) Choicesinclude: ACTIVE and INACTIVE. ACTIVE indicates that the
router has been plugged on the network and can be part of 1SC tasks such as collect config and
provisioning. INACTIVE indicates the router has not been plugged-in. Default: ACTIVE.

CNS Identification Required if the Device Event Identification field is set to CNS_ID. Only valid
characters that Cisco 10S allows are alphanumeric characters and (.) (-) ().

Device Event I dentification (optional) Indicates whether the CNS Identification field contains a
HOST_NAME or CNS _ID. Default: HOST_NAME.

Most Recent CNS event (optional) Choices include: None, CONNECT, and DISCONNECT.
Changing from the default of None is not recommended. Note: The last connect or disconnect CNS
TIBCO event received by |SC for each CNS-enabled |OS device is automatically recorded.

| E2100 (optional) Disabled unless the Device State field is INACTIVE or the Terminal Session
Protocol field is CNS. A valid IE2100 must be selected if the Terminal Session Protocol is CNS.
Choices include: None and the list of existing IE2100 names. Default: None.

CNS Software Version (optional) Choicesinclude: 1.3, 1.3.1, 1.3.2, 1.4, and 1.5. Thisistherelease
version of Cisco CNS Configuration Engine that manages the 10S device. Default: 1.4.

CNS Device Transport (optional) Choicesinclude: HTTP and HTTPS. This field determines what
will be the transport mechanism used by | SC to create, delete, or edit devices in the IE2100
repository. If HTTPS is used, the Cisco CNS Configuration Engine must be running in secure mode.
Default: HTTP.
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The Device Platform Information section of the Cisco |OS Device Properties window contains the
following fields:

- Platform (optional) Should match what is configured on the target router device. Limited to 80
characters.

- Software Version (optional) Should match what is configured on the target router device. Limited
to 80 characters.

« Image Name (optional) Should match what is configured on the target router device. Limited to 80
characters.

« Serial Number (optional) Should match what is configured on the target router device. Limited to
80 characters.

« Device Owner’s Email Address (optional) Used in the To: field when the Email button is selected
from the device list. Limited to 80 characters and must be valid Email format.

Step6  Enter any desired Additional Propertiesinformation for the Cisco |OS device you are creating.
Step7  Click Save.

The Devices window reappears with the new Cisco |OS device listed.

Creating a Terminal Server

To create a Terminal Server device, follow these steps:

Stepl  Choose Service Inventory > Inventory and Connection Manager > Devices.
Step2  Click the Create button.
Step3  Select Terminal Server.

The Create Terminal Server window appears, as shown in Figure 3-79.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 3-79
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The General section of the Create Terminal Server window contains the following fields:

- Device Host Name (required) Must begin with aletter, digit, or underscore followed by letters,
digits, underscores, spaces, hyphens, or dots ending with a letter, digit, or underscore. Thisfield
must match the name configured on the target router device. Limited to 256 characters.

« Device Domain Name (optional) Must begin with aletter, digit, or underscore followed by letters,
digits, underscores, spaces, hyphens, or dots ending with aletter, digit, or underscore. The name
must match the domain name on the target router device.

» Description (optional) Limited to 80 characters. Can contain any pertinent information about the
device such as the type of device, itslocation, or other information that might be helpful to service

provider operators.

« Collection Zone (optional) Drop-down list of all collection zones within the | SC. Choices include:
None and all collection zones within the ISC. Default: None.

Cisco IP Solution Center Infrastructure Reference, 4.2
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- Management | P Address (optional) Valid | P address of the device that | SC uses to configure the
target router device.

» Interfaces (optional) Click the Edit button to view, add, edit, and delete all interfaces associated
with the device. See Table 3-8 for a description of the Interfaces fields.

Table 3-8 Create Terminal Server Device Interfaces Fields
Field Description Additional
Name Name of this interface. List can be sorted by this field.
Limited to 80 characters.
Encapsulation The Layer 2 Encapsulation for  |DEFAULT
this device. DOT1Q
ETHERNET
ISL
FRAME_RELAY
FRAME_RELAY_IETF
HDLC
PPP
ATM
AALS5SNAP
AALO
AALS
AALSMUX
AALS5SNLPID
AAL2
ENCAP_QinQ
GRE
IP Address I P address associated with this
interface.

» Associated Groups (optional) Click the Edit button to view, add, and remove all Device Group
associations.

The Login and Password Information section of the Create Terminal Server window contains the
following fields:

» Login User (optional) Not required by I1SC. However, collection and upload/download will not
function without the Login User and Login Password as ISC will not be able to access the device.
Should match what is configured on the target router device. Limited to 80 characters.

« Login Password (optional) Displayed as stars (*). Not required by ISC. However, collection and
upload/download will not function without the Login User and Login Password as ISC will not be
able to access the device. Should match what is configured on the target router device. Limited to
80 characters.

« Verify Login Password (optional) Displayed as stars (*). Must match the Login Password field.
Limited to 80 characters.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Step 4
Step 5

Enable User (optional) Not required by ISC. However, collection and upload/download only
function if the Login User has sufficient privileges to configure the router in EXEC mode. Should
match what is configured on the target router device. Limited to 80 characters.

Enable Password (optional) Displayed as stars (*). Not required by | SC. However, collection and
upload/download only function if the Login User has sufficient privileges to configure the router in
EXEC mode. Should match what is configured on the target router device. Limited to 80 characters.

Verify Enable Password (optional) Displayed as stars (*). Must match the Enable Password field.
Limited to 80 characters.

The Device and Configuration Access Information section of the Create Terminal Server window
contains the following fields:

Terminal Session Protocol (optional) Configures the method of communication between 1SC and
the device. Choices include: Telnet, Secure Shell (SSH), CNS, and RSH. In previous versions of
ISC, thisfield was called the Transport field. Default: The default set in the DCPL properties.

Config Access Protocol (optional) Administersthe access protocol for config upload and download.
Choices include: Terminal, TFTP, FTP, and RCP. Default: The default set in the DCPL properties.

SNMP Version (optional) Configures the version of SNMP to use when communicating with the
device. Choices include: SNMP v1/v2c and SNMP v3. Default: The default set in the DCPL
properties.

The SNMP v1/v2c section of the Create Terminal Server window contains the following fields:

Community String RO (optional) SNM P Read-Only Community String. Many tasks use SNMP to
access the device. This field must match what is configured on the target router device. Limited to
80 characters.

Community String RW (optional) SNMP Read-Write Community String. Many tasks use SNMP
to access the device. This field must match what is configured on the target router device. Limited
to 80 characters.

Enter the desired information for the Terminal Server you are creating.

To access the Additional Properties section of the Create Terminal Server, click Show.

The Additional Properties window appears, as shown in Figure 3-80.
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Figure 3-80 Terminal Server Device Properties Window
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|
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The SNMP v3 section of the Terminal Server Device Properties window contains the following fields:

« SNMP Security Level (optional) Choicesinclude: Default (<default_set_in_DCPL>),
Authentication/No Encryption, and Authentication/Encryption. Default: Default
(<default_set_in_DCPL>). Note: When you change the DCPL property, the
<default_set_in_DCPL> variable changes.

« Authentication User Name (optional) User name configured on the specified device router. User
must have permission to the object identification numbers (OIDs) specified in the security request
(that is, write permission for aset request, and read permission for aget request). Should match what
is configured on the target router device. Should be provisioned if the SNMP Security Level is
Authentication/No Encryption or Authentication/Encryption. Limited to 80 characters.

« Authentication Password (optional) Displayed as stars (*). Should be provisioned if the SNMP
Security Level is Authentication/No Encryption or Authentication/Encryption. Should match what
is configured on the target router device. Limited to 80 characters.

« Verify Authentication Password (optional) Displayed as stars (*). Must match the Encryption
Password field. Limited to 80 characters.

» Authentication Algorithm (optional) Should be provisioned if the SNMP Security Level is
Authentication/No Encryption or Authentication/Encryption. Choices include: None, MD5, and
SHA.. Default: None.

- Encryption Password (optional) Displayed as stars (*). In previous versions of 1SC, thisfield was
called Privacy Password. Should match what is configured on the target router device. Should be
provisioned if the SNMP Security Level is Authentication/Encryption. Limited to 80 characters.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Step 6
Step 7

Verify Encryption Password (optional) Displayed as stars (*). Must match the Encryption
Password field. Limited to 80 characters.

Encryption Algorithm (optional) In previous versions of 1SC, this field was called Privacy
Protocol. Should be provisioned if the SNMP Security Level is Authentication/Encryption. Choices
include: None and DES 56. Default: None.

The Device Platform Information section of the Terminal Server Device Properties window contains the
following fields:

Platform (optional) Should match what is configured on the target router device. Limited to 80
characters.

Softwar e Version (optional) Should match what is configured on the target router device. Limited
to 80 characters.

Image Name (optional) Should match what is configured on the target router device. Limited to 80
characters.

Serial Number (optional) Should match what is configured on the target router device. Limited to
80 characters.

Device Owner’s Email Address (optional) Used in the To: field when the Email button is selected
from the device list. Limited to 80 characters and must be valid Email format.

Enter any desired Additional Properties information for the Terminal Server device you are creating.
Click Save.
The Devices window reappears with the new Terminal Server device listed.

Creating a Cisco CNS IE2100

~

Note

Step 1
Step 2
Step 3

To use the Cisco CNS |E2100 functionality on I SC, you must first set up the Cisco CNS |E2100
appliance and the ISC workstation as explained in Appendix B, “ Setting Up Cisco CNS IE2100
Appliances with ISC” in the Cisco | P Solution Center Installation Guide, 4.2. You must also create a
Cisco 10S device to communicate with the Cisco CNS |E2100 appliance. See Appendix A, “ Setting Up
Oracle for ISC,” in the Cisco IP Solution Center Installation Guide, 4.2.

To create a Cisco CNS IE2100 appliance, follow these steps:

Choose Service Inventory > Inventory and Connection Manager > Devices.
Click the Create button.

Select 1 E2100.

The Create |IE2100 Device window appears, as shown in Figure 3-81.
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Figure 3-81 Create IE2100 Device Window

General
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The General section of the Create IE2100 Device window contains the following fields:

- Device Host Name (required) Must begin with a letter, digit, or underscore followed by letters,
digits, underscores, spaces, hyphens, or dots ending with a letter, digit, or underscore. Thisfield
must match the name configured on the target router device. Limited to 256 characters.

- Device Domain Name (optional) Must begin with aletter, digit, or underscore followed by letters,
digits, underscores, spaces, hyphens, or dots ending with a letter, digit, or underscore. The name
must match the domain name on the target router device.

- Description (optional) Limited to 80 characters. Can contain any pertinent information about the
device such as the type of device, itslocation, or other information that might be helpful to service
provider operators.

« |P Address (optional) Valid I P address of the Cisco CNS IE2100 device that I SC uses to configure
the target router device.

Step4  Enter the desired information for the Cisco CNS IE2100 device you are creating.
Step5  Click Save.
The Devices window reappears with the new Cisco CNS IE2100 device listed.

Editing a Device

From the Edit window, you can modify the fields that have been specified for a particular device.

To access the Edit window, follow these steps:

Stepl  Choose Service Inventory > Inventory and Connection Manager > Devices to access the Devices
window shown in Figure 3-82.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 3-82
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Step2  Select asingle device to edit by checking the box to the left of the Device Name. You can also select a
device to edit by clicking on the hyperlink of the device name.

Step3  Click the Edit button. This button is only enabled if a device is selected.

The Edit window appropriate to the type of device selected appears. For example, if you selected a Cisco
| OS device the Edit Cisco 10S Device window appears, as shown in Figure 3-83.
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Enter the changes you want to make to the selected device.

Click Save.
The changes are saved and the Devices window reappears.

Devices I
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Deleting Devices

From the Delete window, you can remove selected devices from the database.

To access the Delete window, follow these steps:

Stepl  Choose Service Inventory > Inventory and Connection Manager > Devices to access the Devices
window shown in Figure 3-84.

Figure 3-84 Devices List Window
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6. [] & ce3 Cisca I0S Device
7.0 & ces Cisco 105 Device
8. [] &8 cels Cisca I0S Device
Rows per page: | 10+ <] €] Goto page: 1 of 1 U [0
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158147

Step2  Select one or more devices to delete by checking the check box(es) to the left of the Device Name(s).

Step3  Click the Delete button. This button is only enabled if one or more devices are selected.

The Confirm Delete window appears, as shown in Figure 3-85.

Figure 3-85

Confirm Delete

Confirm Delete Window

Confirm Delete
Showing 1 -1 of 1 record
. Management IP Parent Device
# Device Hame Address Type Name
1. ensw3g50-1.cisco.com Cigco 105 Device

Rows per page:l 10 j

[<]<] Gotao page:l‘l of 1 [z (=0

| Delete || Cancel |

149142
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Click the Delete button to confirm that you want to delete the device(s) listed.

The Devices window reappears with the specified device(s) deleted.

Editing a Device Configuration

Step 1

Step 2
Step 3

From the Config window, you can edit the configuration for a specified device.

To access the Config window, follow these steps:

Choose Service Inventory > Inventory and Connection Manager > Devices to access the Devices
window shown in Figure 3-86.

Figure 3-86 Devices List Window
Devices
Show Devices with | Device Mame ~ | matching |
% Showving 1 - 8 of & records
- Management IP -
# |:| Device Hame Address Type Parent Device Hame
1. ] & pet Cisco 105 Device
2. [] & pes Cisca I0S Device
3. [0 &8 =sw2 Cisco 105 Device
4. [] & =ws3 Cisca I0S Device
5. ] & =swd Cisco 105 Device
6. [] & ce3 Cisca I0S Device
7.0 & ced Cisco 105 Device
8. [] &8 cels Cisca I0S Device
Rovws per page: | 10+ <] €] Goto page: 1 of 1 U [0
crowo [ car [| vete [if conna || £mu || cony |

158147

Select a single device to modify by checking the check box to the left of the Device Name.

Click the Config button.

The Device Configurations window for the selected device appears, as shown in Figure 3-87.

| oL-10727-01
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Step 4

Step 5
Step 6

Step 7

Figure 3-87 Device Configurations Window

Device Configurations

Device: ensw2950-1.cisco.com Allowed Configs: unlimited

Showing 1- 3 of 3 records

# [ Date Recyclable

1. [T Mov0BOBS53:21 PMPST fes
2. [T Mov0206:41:30 PMPST fes
3. [T Mov08 063756 PMPST fes

Fows perpage: | 10 j 1<] €] Goto page: |1 of 1 |

| Edit || Delete || oK
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Check the box to the left of the Date for the configuration that you want to modify and click the Edit

button. This button is only enabled if a device is selected.

The Device Configuration window for the selected device appears, as shown in Figure 3-88.

Figure 3-88 Device Configuration Window

Device Configuration

[

Device: vymd-2950b Config: Mar 18 02:04:52 PM PST Recyclable: i

i s
wversion 12.0

no service pad

service timestamps debug uptime

service timestamps log uptime

no service password-encryption

]
hostname vwd-z2950b

]

enahle password movedZnw
]

ip subnet-zero

no ip domain-lookup
]

! =l

Cancel

o
—
uxl
(ul
i)

Enter the changes you want to make to the selected device configuration.
Click Save.

The changes are saved and the Device Configurations window reappears.
Click OK to return to the Devices window.

Cisco IP Solution Center Infrastructure Reference, 4.2

oL-10727-01 |



| Chapter3

Service Inventory — Inventory and Connection Manager

Devices I

E-mailing a Device’s Owner

Step 1

Step 2

Step 3

From the E-mail window, you can send a device report via e-mail to the owners of specified devices.

To access the E-mail window, follow these steps:

Choose Service Inventory > Inventory and Connection Manager > Devices to access the Devices
window shown in Figure 3-89.

Figure 3-89

Devices

Devices List Window

Showe Devices with | Device Name ~ | matching |~

Showving 1 - 8 of & records
Management IP

# |:| Device Hame Address Type Parent Device Hame
1. ] & pet Cisco 105 Device
2. [] & pes Cisca I0S Device
3. [0 &8 =sw2 Cisco 105 Device
4. [] & =ws3 Cisca I0S Device
5. ] & =swd Cisco 105 Device
6. [] & ce3 Cisca I0S Device
7.0 & ced Cisco 105 Device
8. [] &8 cels Cisca I0S Device
Rovws per page: | 10+ <] €] Goto page: 1 of 1 U [0
crosts | cox [ ooete [ff coono | cman | com |

158147

Select the devices for which you want to send a device report by checking the check box(es) to the left
of the Device Name(s).

Click the E-mail button. This button is only enabled if one or more devices are selected.

The Send Mail to Device Owners window appears, as shown in Figure 3-90.

| oL-10727-01
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Figure 3-90 Send Mail to Device Owners Window

Send Mail to Device owners

Please separate E-mail addresses using comma.

To: I

foles |

Subject: ID evice Report
Meszage: d

w
4] ;

93789

Step4  Compose the e-mail that you want to send to the selected device owners.
Step5  Click Send.
The e-mail is sent and the Devices window reappears.

Copying a Device

From the Copy window, you receive a copy of the chosen device and can name it and change values.

To access the Copy window, follow these steps:

Stepl  Choose Service Inventory > Inventory and Connection Manager > Devices to access the Devices
window shown in Figure 3-91.
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Figure 3-91 Devices List Window
Devices
Show Devices with | Device Mame ~ | matching |
% Showving 1 - 8 of & records
- Management IP -
# |:| Device Hame Address Type Parent Device Hame
1. ] & pet Cisco 105 Device
2. [] & pes Cisca I0S Device
3. [0 &8 =sw2 Cisco 105 Device
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Select a single device to copy by checking the check box to the left of the Device Name.

Click the Copy button. This button is only enabled if a device is selected.

A window appropriate to the type of device selected to copy appears. You receive an exact copy of the
selected device but the Name, Management |P Address, all Interfaces, and VPNSM bladesfor a Catalyst
Switch running Cisco |0S are blanked out and you must fill in the required information and save this
new device. See the “ Creating a Device” section on page 3-76 for specifics.

Device Groups

Every network element that | SC manages must be defined as a device in the system. After you have
defined your network elements as devices, you can organize the devices into groups for collection and
management purposes.

This section describes how to create, edit, and delete device groups and e-mail device group owners. This
section includes the following:

= Accessing the Device Groups Window, page 3-102

» Creating a Device Group, page 3-102
- Editing a Device Group, page 3-105

« Deleting Device Groups, page 3-105

« E-mailing a Device Group, page 3-106

| oL-10727-01
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Accessing the Device Groups Window

The Device Groups feature is used to create, edit, and delete device groups and e-mail device group
owners.

To access the Device Groups window, follow these steps:

Stepl  Choose Service Inventory > Inventory and Connection Manager > Device Groups to access the
Device Groups window shown in Figure 3-92.

Figure 3-92 Device Groups Window

Device Groups

Show Device Groups with | Device Group Name j matching I* Iﬂl
Showving 1-4 of 4 records
# Device Group Hame Description
. T aroupt

1

2. [T Device Group 1
3. [T Device Group B
4

. T DeviceC

Rows per page: I 1a 'l

| Create | |

93820

The Device Groups window contains the following:
» Device Group Name Liststhe name of the device group. You can sort thelist by device group name.
« Description Lists the description of the device group.

From the Device Groups window, you can create, edit, or delete device groups or e-mail device group
owners using the following buttons:

» Create Click to create new device groups. Enabled only if no device group is selected.

» Edit Click to edit a selected device group (select device group by checking the corresponding box).
Enabled only if asingle device group is selected.

- Delete Click to delete selected device group(s) (select device group by checking the corresponding
box). Enabled only if one or more device groups are selected.

- E-mail Click to send e-mail to the owner of aselected device group (sel ect device group by checking
the corresponding box). Enabled only if one or more device groups are selected.

Creating a Device Group

From the Create Device Group window, you can create different device groups.

To create a device group, follow these steps:

Stepl  Choose Service Inventory > Inventory and Connection Manager > Device Groups.
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Step2  Click the Create button.

The Create Device Group window appears, as shown in Figure 3-93.

Figure 3-93 Create Device Group Window

Create Device Group

Mame :
Description:
Devices: # Marne De=cription Edit |

Rows per page; I 10 =| 14] ] Goto page: |1 of 1 [ [0

| Sanwe || Cancel |

117443

Mate; * - Reguired Field

The Create Device Group window contains the following fields:

- Name (required) Must begin with aletter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with a letter, digit, or underscore. Limited to 80
characters.

« Description (optional) Any pertinent information about the device group that could be helpful to
service provider operators. Limited to 512 characters.

Step3  Enter the name and the description of the Device Group that you are creating.
Step4  Click Edit.
The Select Group Members window appears, as shown in Figure 3-94.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 3-94 Select Group Members Window

Select Group Members

T et eiee e
o Sovimtsotsreoons
II:I—_

II:I__

II:I__
10 v %)

o |

Step5  Select the devicesthat you want to be group members by checking the check box to the eft of the device
name.

Step6  Click OK.

158148

The Create Device Group window appears listing the selected devices, as shown in Figure 3-95.

Figure 3-95 Create Device Group Window

ECreate Device Group

:Nnte: * _ Required Field

152149

Step7  Click Save.

The Device Groups window reappears with the new device group listed.
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Editing a Device Group

Step 1
Step 2
Step 3

Step 4
Step 5

From the Edit Device Group window, you can modify the fields that have been specified for a particular
device group.

To access the Edit Device Group window, follow these steps:

Choose Service Inventory > Inventory and Connection Manager > Device Groups.

Select asingle device group to modify by checking the check box to the left of the Device Group Name.
Click the Edit button. This button is only enabled if a device group is selected.

The Edit Device Group window appears, as shown in Figure 3-96.

Figure 3-96 Edit Device Group Window

Edit Device Group

Mame - Groups
Description:
Devices: # Marne De=cription Edit |

Rows per page; I 10 =| 14] ] Goto page: |1 of 1 [ [0

| Sanwe || Cancel |

117445

Mate: * - Reguired Field

Enter the changes you want to make to the selected device group.
Click Save.
The changes are saved and the Device Groups window reappears.

Deleting Device Groups

Step 1
Step 2

Step 3

From the Delete window, you can remove selected device groups from the database.
To access the Delete window, follow these steps:

Choose Service Inventory > Inventory and Connection Manager > Device Groups.

Select one or more device groups to delete by checking the check box(es) to the left of the Device Group
Names.

Click the Delete button. This button is only enabled if one or more device groups are selected.

The Confirm Delete window appears, as shown in Figure 3-97.

| oL-10727-01
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Figure 3-97 Confirm Delete Window

Confirm Delete

Confirm Delete
Showing 1-1 of 1 recaords

# Mame Dezcription Aszociated Devices

1. San Jose Devices located in San Joze. ences] | encebl

Rowvs per page: I 1 'I

93828

Step4  Click the Delete button to confirm that you want to delete the device group(s) listed.
The Device Groups window reappears with the specified device group(s) deleted.

E-mailing a Device Group

From the E-mail window, you can send a device report via e-mail to the owners of specified device
groups.

To access the E-mail window, follow these steps:

Stepl  Choose Service Inventory > Inventory and Connection Manager > Device Groups.

Step2  Select the device groups for which you want to send a device report by checking the check box to the
left of the Device Group Name.

Step3  Click the E-mail button. This button is only enabled if one or more device groups are selected.

The Send Mail to Device owners of selected groups window appears, as shown in Figure 3-98.
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Figure 3-98 Send Mail to Device Owners of Selected Groups Window

Sen\t]JMail to Device owners of selected groups

Please separate E-mail addresses using comma.

T I

ol |

Subject: IDevice Group Report
Messane: ;I

w
i »

93825

Step4  Compose the e-mail that you want to send to the selected device group owners.
Step5  Click Send.
The e-mail is sent and the Device Groups window reappears.

Customers

A customer siteis a set of |P systems with mutual |P connectivity between them without the use of a
VPN. Each customer site belongs to exactly one customer. A customer site can contain one or more (for
load balancing) edge device routers. This section describes how to create, edit, and delete customers.
This section includes the following:

» Accessing the Customers Window, page 3-108
« Creating a Customer, page 3-108

« Editing a Customer, page 3-109

» Deleting Customers, page 3-110

- Creating Customer Sites, page 3-111

- CPE Devices, page 3-112
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Accessing the Customers Window

The Customers feature is used to create, edit, and delete customers.

To access the Customers window, follow these steps:

Stepl  Choose Service Inventory > Inventory and Connection Manager > Customer s to access the
Customers window shown in Figure 3-99.

Figure 3-99 Customers Window
Customers
Show Customers with Customer Name matching -
Showing 1-3 of 3 records
# [
1. [
2 m
3 O
Rows per page: 0 >

93235

The Customers window contains the following:
« Customer Name Lists the names of customers. You can sort the list by customer name.

From the Customers window, you can create, edit, or delete customers using the following buttons:
- Create Click to create new customers.

- Edit Click to edit selected customer (select by checking the corresponding box). Enabled only if a
single customer is selected.

» Delete Click to delete selected customer (select customer by checking the corresponding box).
Enabled only if one or more customers are selected.

Creating a Customer

From the Create Customer window, you can create different customers.
To create a customer, follow these steps:

Stepl1  Choose Service Inventory > Inventory and Connection Manager > Customers.
Step2  Click the Create button.
The Create Customer window appears, as shown in Figure 3-100.
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Figure 3-100 Create Customer Window

Create Customer

«
Mame : I

Custorner Abbreviation: I

Contact Infarrnstion:

Site of Origin Enabled: ¥ [

Sawve Cancel

129014

Maote: * - Reguired Field

The Create Customer window contains the following fields:

« Name (required) Must begin with aletter. Can contain letters, numbers, and these punctuation
characters: period, underscore, and dash. Limited to 80 characters.

- Customer Abbreviation Thisfield in used only for L2VPN and L2TPv3 Frame Relay service
requests. The entry in this field is used to construct a connect name. When this field is left blank,
DLCI switching is the transport mode used. Limited to 9 characters.

- Customer Information (optional) Any pertinent information about the customer that could be
helpful to service provider operators. Limited to 256 characters.

- Siteof Origin Enabled (optional) This check box appears only when you have MPL S permissions.
Check this check box to enable the site of origin.

Step3  Enter the name and information for the Customer that you are creating. Check the Site of Origin
Enabled check box if you want this enabled.

Step4  Click Cancel if you do not want to save this information, and you will proceed to the previous window.
Otherwisg, click Save. The changes are then saved and the Customers window reappears.

Editing a Customer

From the Edit Customer window, you can modify the fields that have been specified for a particular
customer.

To access the Edit Customer window, follow these steps:

Stepl  Choose Service Inventory > Inventory and Connection Manager > Customers.
Step2  Select asingle customer to modify by checking the check box to the left of the Customer Name.
Step3  Click the Edit button. This button is only enabled if a customer is selected.

Cisco IP Solution Center Infrastructure Reference, 4.2
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The Edit Customer window appears, as shown in Figure 3-101.

Figure 3-101 Edit Customer Window

Edit Custoemer

Mame ; |Cust0mer1

Gustomer Ahbreviation: ICUST1

Cortact Infarmation:

=
Enable Site of Origin: “-io) |_

Save || A

129012

Mote: * - Reouired Field

Step4  Enter the changes you want to make to the selected customer.
Step5  Click Cancel if you do not want to save this information, and you will proceed to the previous window.
Otherwisg, click Save. The changes are then saved and the Customers window reappears.

Deleting Customers

From the Delete window, you can remove selected customers from the database.

To access the Delete window, follow these steps:

Stepl  Choose Service Inventory > Inventory and Connection Manager > Customers.
Step2  Select one or more customers to delete by checking the check box to the left of the Customer Name.
Step3  Click the Delete button. This button is only enabled if one or more customers are selected.

The Confirm Delete window appears, as shown in Figure 3-102.
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Figure 3-102 Confirm Delete Window

Delete Customer

Confirm Delete
Showing 1-1 of 1 recaords
# Mame
1. Custamer2

Rows per page: |10

9524

Step4  Click Cancel if you do not want to save this information, and you will proceed to the previous window.

Otherwisg, click Deleteto confirm that you want to delete the customer(s) listed. The Customerswindow
reappears with the specified customer(s) del eted.

Creating Customer Sites

To access the Customer Sites window, follow these steps:

Stepl  Choose Service Inventory > Inventory and Connection M anager.

Step2  Click on Customer Siteslisted in the Inventory and Connection Manager tree in the left column under
Customers.

The Customer Sites window appears.

Figure 3-103 Customer Sites Window

Customer Sites

Showe Stes with | Site Mame ~ | matching |*
Showing 1 - 2 of 2 records
# [ ] Site Hame Customer Hame
1. [ east Customer
2, [] |west Custamer1
Rows per page: | 100 1] €] Goto page: 1 of1 [+ =1
| creste || I |

158150

The Customer Sites window contains the following:

- SiteNameListsthe names of sites. Thefirst character must be aletter. Can contain letters, numbers,
and these punctuation characters: period, underscore, and dash. Limit: 80 characters. You can sort
the list by site name.

Cisco IP Solution Center Infrastructure Reference, 4.2
[ oL-10727-01 .m



Chapter 3 Service Inventory — Inventory and Connection Manager |

W Customers

» Customer Name Lists the names of customer. The first character must be a letter. Can contain
letters, numbers, and these punctuation characters: period, underscore, and dash. Limit: 80
characters. You can sort the list by customer name.

From the Customer Sites window, you can create, edit, or delete customer sites using the following
buttons:

» Create Click to create new customer sites. Enabled only if no customer site is selected.

- Edit Click to edit selected customer sites (select by checking the corresponding box). Enabled only
if asingle customer site is selected.

« Delete Click to delete selected customer site(s) (select by checking the corresponding box(es)).
Enabled only if one or more customer sites are selected.

CPE Devices

The CPE feature provides alist of CPEs that have been associated with a site through the CPE editor or
Inventory Manager. To access the CPE Devices window, follow these steps:

Stepl  Choose Service Inventory > Inventory and Connection Manager.

Step2  Click on CPE Devices listed in the Inventory and Connection Manager tree in the left column under
Customers.

The CPE Devices window appears.

Figure 3-104 CPE Devices Window

CPE Devices
Showe CPE= with | Device Mame “ | matching |
Showving 1 - 3 of 3 records
# |:| Device Hame Customer Hame Site Hame Management Type Service Request
1. [] & ce3 Customer] east hanaged MPLS
2. ] &9 ces Custamer west hanaced
3. [ &9 cel3 Customer] east hanaged
Rows per page: [ 10w <] €] Goto page: 1 of 1 B [0

 creste || e ] epioy [] ooete |

188151

The CPE Devices window contains the following:

« Device Name Lists the names of devices. The first character must be a letter. Can contain letters,
numbers, and these punctuation characters: period, underscore, and dash. Limit: 80 characters. You
can sort the list by device name.

» Customer Name Lists the names of customer. The first character must be a letter. Can contain
letters, numbers, and these punctuation characters: period, underscore, and dash. Limit: 80
characters. You can sort the list by customer name.
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- SiteName Liststhe names of sites. Thefirst character must be aletter. Can contain letters, numbers,
and these punctuation characters: period, underscore, and dash. Limit: 80 characters. You can sort
the list by site name.

- Management Type When associating a CE with a customer site, you can select Managed or
Unmanaged. Other choices are available (see below), but they should not be confused with this
primary choice.

Create CPE Device

Managed—A managed CE can be provisioned directly by the provider using I SC. The CE must
be reachable from an | SC server.

Unmanaged —An unmanaged CE cannot be provisioned directly by the provider. If Unmanaged
isselected, the provider can use | SC to generate a configuration, and then send the configuration
to the customer for placement on the CE.

Managed - Management LAN —A managed Management LAN or Management CE (MCE) is
configured like a managed CE router, but it resides in the provider space. Normally, an MCE
acts as the network operations center (NOC) gateway router.

Unmanaged - Management LAN —An unmanaged Management LAN or MCE is configured
like an unmanaged CE router, but it residesin the provider space. Normally, an MCE acts asthe
network operations center (NOC) gateway router.

Directly Connected —In most cases, the CE is connected to a PE router. In this case, the CE is
connected to a workstation or other device.

Directly Connected Management Host —In most cases, the CE is connected to a PE router. In
this case, the CE is connected to a workstation or other device, on which 1SC resides.

Multi-VRF —A multi-VRF CE (MVRFCE) is owned by the customer, but resides in the
provider space. It is used to off-load traffic from the PE.

Unmanaged Multi-VRF—AnN unmanaged multi-VRF CE is provisioned like an unmanaged CE
(configurations are not uploaded or downloaded to the device by the provider). It is owned by
the customer and resides in the provider space.

This section explains how to create a CPE device.

Stepl  Click Createto create new CPE devices. Enabled only if no customer site is selected. The resulting
window is shown in Figure 3-105, “Create CPE Device Window.”

| oL-10727-01
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Figure 3-105 Create CPE Device Window

Create CPE Device

Device Namex:
Site Mam ex:

Management Type: kanaged -

116250

Mate: * - Required Field

Step2  Click Select for the required Device Name and Site Name. For each, you receive alist of the devices
and sites, respectively, from which you can choose one in each window and then click Select. Click
Cancel if you do not want to save this information, and you will proceed to the previous window.

Step3  The drop-down window for Management Type allows you choose the management type of the CPE
device you are creating.

Step4  Click Cancel if you do not want to save this information, and you will proceed to the previous window.

Otherwisg, click Save. The changes are saved and the CPE Device window reappears.

Edit CPE Device

Click Edit to edit asingle CPE device selected in Figure 3-104. The result is a window as shown in the
example in Figure 3-106, “Edit CPE Device Window,” for which you can make changes and Save.
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Delete CPE Device

Click Delete to delete selected CPE device(s) (select by checking the corresponding box). Enabled only
if one or more CPE devices are selected. A Confirm Delete window allows you to continue with the
deletion or cancel this deletion.

Providers

This section describes how to create and manage providers. This section includes the following:
» Accessing the Providers Window, page 3-116
« Creating a Provider, page 3-116
- Editing a Provider, page 3-117
» Deleting Providers, page 3-118
» Creating Provider Regions, page 3-119
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» Creating PE Devices, page 3-120
» Creating Access Domains, page 3-121

Accessing the Providers Window

The Providers feature is used to create and manage providers.
To access the Providers window, follow these steps:

Stepl1  Choose Servicelnventory > Inventory and Connection Manager > Provider sto access the Providers
window shown in Figure 3-107.

Figure 3-107 Providers Window

Providers
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Showing 1 -1 of 1 record
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Rows per page: [ 10w <] €] Goto page: 1 of 1 B [0
[ create | I |
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The Providers window contains the following:
» Provider Name Lists the names of providers. You can sort the list by provider name.

» Provider BGP AS The Unique number assigned to each BGP autonomous system. Range: 1 to
65535.

From the Providers window, you can create, edit, or delete providers using the following buttons:
« Create Click to create new providers. Enabled only if no customer is selected.

« Edit Click to edit a selected provider (check the corresponding box). Enabled only if asingle
provider is selected.

- Delete Click to delete selected provider(s) (check the corresponding box(es)). Enabled only if one
or more providers are selected.

Creating a Provider

From the Create Provider window, you can create different providers.
To create a provider, follow these steps:

Stepl  Choose Service Inventory > Inventory and Connection Manager > Providers.
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Click the Create button.
The Create Provider window appears, as shown in Figure 3-108.

Figure 3-108 Create Provider Window
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The Create Provider window contains the following fields:

- Name (required) Must begin with aletter. Can contain letters, numbers, and these punctuation
characters: period, underscore, and dash. Limited to 80 characters.

« BGP AS (required) Each BGP autonomous system is assigned a unique 16-bit number by the same
central authority that assigns IP network numbers. Range: 1 to 65535.

- Contact I nformation (optional) Any pertinent information about the provider that could be helpful
to service provider operators. Limited to 256 characters.

Enter the name, BGP AS, and any contact information for the Provider that you are creating.
Click Save.

The Providers window reappears with the new provider listed.

Editing a Provider

Step 1
Step 2
Step 3

From the Edit Provider window, you can modify the fields that have been specified for a particular
provider.

To access the Edit Provider window, follow these steps:

Choose Service Inventory > Inventory and Connection Manager > Providers.

Select a single provider to modify by checking the check box to the left of the Provider Name.
Click the Edit button. This button is only enabled if a customer is selected.

The Edit Provider window appears, as shown in Figure 3-109.

| oL-10727-01
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Figure 3-109 Edit Provider Window
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Step4  Enter the changes you want to make to the selected provider.
Step5  Click Save.

The changes are saved and the Providers window reappears.

Deleting Providers

From the Delete window, you can remove selected providers from the database.

To access the Delete window, follow these steps:

Stepl  Choose Service Inventory > Inventory and Connection Manager > Providers.
Step2  Select provider(s) to delete by checking the check box to the left of the Provider Name.
Step3  Click the Delete button. This button is only enabled if one or more Providers are selected.

The Confirm Delete window appears, as shown in Figure 3-110.
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Figure 3-110 Confirm Delete Window
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Step4  Click the Delete button to confirm that you want to delete the provider(s) listed.
The Providers window reappears with the specified provider(s) deleted.

Creating Provider Regions

A Provider Region is considered to be a group of provider edge routers (PES) within a single BGP
autonomous system. The primary objective for defining Provider Regionsisto allow a provider to
employ unique | P address poolsin large Regions, such as Europe, Asia Pacific, and so forth.

To access the Provider Regions window, follow these steps:

Stepl1  Choose Service Inventory > Inventory and Connection Manager.

Step2  Click onProvider Regionslisted in the Inventory and Connection Manager treein theleft column under
Providers.

The Provider Regions window appears.

Figure 3-111 Provider Regions Window
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The Provider Regions window contains the following:

« PE Region Name Liststhe names of regions. Must begin with aletter. Can contain letters, numbers,
and these punctuation characters: period, underscore, and dash. Limited to 80 characters. You can
sort the list by region name.

Cisco IP Solution Center Infrastructure Reference, 4.2
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- Provider Name Liststhe names of providers. Must begin with aletter. Can contain letters, numbers,
and these punctuation characters: period, underscore, and dash. Limited to 80 characters. You can
sort the list by provider name.

From the Provider Regions window, you can create, edit, or delete provider regions using the following
buttons:

- Create Click to create new provider regions. Enabled only if no customer is selected.

- Edit Click to edit selected provider regions (check the corresponding box). Enabled only if asingle
provider region is selected.

» Delete Click to delete selected provider regions (check the corresponding box(es)). Enabled only if
one or more provider regions are selected.

Creating PE Devices

The PE Devices feature provides alist of provider edge routers (PEs) that have been associated with the
region, either through the PE editor or Inventory Manager.

To access the PE Devices window, follow these steps:

Stepl  Choose Service Inventory > Inventory and Connection Manager.

Step2  Click on PE Devices listed in the Inventory and Connection Manager tree in the left column under
Providers.

The PE Devices window appears.

Figure 3-112 PE Devices Window
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The PE Devices window contains the following:

- Device Name Lists the names of devices. The first character must be a letter. Can contain letters,
numbers, and these punctuation characters: period, underscore, and dash. Limit: 80 characters. You
can sort the list by device name.
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- Provider Name Liststhe names of providers. Must begin with aletter. Can contain letters, numbers,
and these punctuation characters: period, underscore, and dash. Limited to 80 characters. You can
sort the list by provider name.

» Region Name Lists the names of regions. Must begin with aletter. Can contain letters, numbers,
and these punctuation characters: period, underscore, and dash. Limited to 80 characters. You can
sort the list by region name.

» Role Type Choicesinclude: N-PE, U-PE, P, PE_AGG.
From the PE Devices window, you can create, edit, or delete providers using the following buttons:
» Create Click to create new PE device. Enabled only if no PE device is selected.

« Edit Click to edit selected PE device (check the corresponding box). Enabled only if a single PE
device is selected.

- Delete Click to delete selected PE device(s) (check the corresponding box(es)). Enabled only if one
or more PE devices are selected.

Creating Access Domains

To access the Access Domains window, follow these steps:

Stepl  Choose Service Inventory > Inventory and Connection M anager.

Step2  Click on Access Domainslisted in the Inventory and Connection Manager tree in the left column under
Providers.

The Access Domains window appears.

Figure 3-113 Access Domains Window
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The Access Domains window contains the following:

« Access Domain Name Lists the names of access domain. The first character must be aletter. Can
contain letters, numbers, and these punctuation characters: period, underscore, and dash. Limit: 80
characters. You can sort the list by access domain name.

- Provider Name Liststhe names of providers. Must begin with aletter. Can contain letters, numbers,
and these punctuation characters: period, underscore, and dash. Limited to 80 characters. You can
sort the list by provider name.
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From the Access Domains window, you can create, edit, or delete access domains using the following
buttons:

Create Click to create new access domain. Enabled only if no access domain is selected.

Edit Click to edit a selected access domain (check the corresponding box). Enabled only if asingle
access domain is selected.

Delete Click to delete selected access domain(s) (check the corresponding box(es)). Enabled only
if one or more access domains are selected.

Resource Pools

Cisco I P Solution Center enables multiple poolsto be defined and used during operations. The following
resource pools are available;

IP address pool: The |P address pool can be defined and assigned to regions or VPNSs. This feature
gives the service operator the flexibility to manage the allocation of all IP addresses in the network.

Multicast pool: The Multicast pool is used for Multicast MPLS VPNs.

Route Target (RT) pool: A routetarget isthe MPLS mechanism that informs PEs as to which routes
should be inserted into the appropriate VRFs. Every VPN route is tagged with one or more route
targetswhenit isexported from aV RF and offered to other VRFs. Theroutetarget can be considered
a VPN identifier in MPLS VPN architecture. RTs are a 64-bit number.

Route Distinguisher (RD) pool: The IP subnets advertised by the CE routers to the PE routers are
augmented with a 64-bit prefix called aroute distinguisher (RD) to make them unique. The resulting
96-bit addresses are then exchanged between the PEs, using a special address family of
Multiprotocol BGP (referred to as MP-BGP). The RD pool is apool of 64-hit RD values that Cisco
IP Solution Center uses to make sure the IP addresses in the network are unique.

Site of origin pool: The pool of values for the site-of-origin (SOO) attribute. The site-of-origin
attribute prevents routing loops when a site is multihomed to the MPLS VPN backbone. Thisis
achieved by identifying the site from which the route was learned, based on its SOO value, so that
it is not readvertised back to that site from a PE in the MPLS VPN network.

VC ID pool: VC ID pools are defined with a starting value and a size of the VC ID pool. (VCID is
a 32-bit unique identifier that identifies a circuit/port.) A given VC ID pool is not attached to any
Inventory object. During the deployment of an Ethernet Service (EWS, ERSfor example), VCID is
auto-allocated from the VC ID pool.

VLAN ID pool: VLAN ID pools are defined with a starting value and a size of the VLAN pool. A
given VLAN ID pool can be attached to an Access Domain. During the deployment an Ethernet
Service (EWS, ERS for example), VLAN ID can be auto-allocated from the Access Domain’s
VLAN pools. This gives the Service Provider atighter control of VLAN ID allocation.

All these resources, that are made available to the service provider, enable the automation of service
deployment.

This section describes how you can create and manage pools for various types of resources. This section
includes the following:

Accessing the Resource Pools Window, page 3-123
Creating an |P Address Pool, page 3-124
Creating a Multicast Pool, page 3-125
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» Creating a Route Distinguisher and Route Target Pool, page 3-126
- Creating a Site of Origin Pool, page 3-128

» Creating aVC ID Pool, page 3-130

« Creating a VLAN Pool, page 3-130

» Deleting Resource Pools, page 3-132

Accessing the Resource Pools Window

Step 1

The Resource Pools feature is used to create and manage various types of resource pools.

To access the Resource Pools window, follow these steps:

Choose Service Inventory > Inventory and Connection Manager > Resour ce Pools to access the
Resource Pools window shown in Figure 3-114.

Figure 3-114 Resource Pools Window
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From the Resource Pools window, you have access to the following buttons:

» Pool Type Choicesinclude: IP Address, Multicast, Route Distinguisher, Route Target, Site of
Origin, VC ID, and VLAN. The fields displayed in the Resource Pools window vary depending on
the pool type selected.

- Create Click to create new resource pools. Enabled only if no resource pool is selected.

- Delete Click to delete selected resource pools (select by checking the corresponding box(es)).
Enabled only if one or more resource pools are selected.

| oL-10727-01
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Creating an IP Address Pool

I SC uses | P address pools to automatically assign | P addresses to PEs and CEs. Each Region has an |P
address pool to use for IP numbered addresses (/30 pools) and a separate | P address pool for IP
unnumbered addresses (/32 loopback address pools).

Within aVVPN or extranet, all |P addresses must be unique. Customer | P addresses must not overlap with
the provider's | P addresses. Overlapping | P addresses are only possible when two devices cannot see
each other—that is, when they are in isolated VPNSs.

From the Create | P Address Pool window, you can create | P address pools.

To create an | P address poal, follow these steps:

Stepl  Choose Service Inventory > Inventory and Connection Manager > Resour ce Pools.
Step2  Select | P address from the Pool Type in the upper left of the Resource Pools window.
Step3  Click the Create button.

The Create | P Address Pool window appears, as shown in Figure 3-115.

Figure 3-115 Create IP Address Pool Window
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The Create | P Address Pool window contains the following fields:
e |P Address Pool (required) Text field in the format a.b.c.d/mask, for example 172.0.0.0/8.
» Pool Mask (bits) (required) Choices include: 30 and 32
where:
30 is used for IP numbered address pools (/30)
32 isused for IP unnumbered loopback address pools (/32).

» Pool Association (required) Choices include: Region, VPN, and Customer from the drop-down
list. Then you can click the Select button to receive all selections for the choice you made in the
drop-down list. From this new window, make your selection and click Select.

Note If you choose VPN, an additional optional field appears, Pool Name Suffix, when you return to
Figure 3-115. This field allows the creation of multiple address pools within the same VPN. If
you are creating this address pool for DMV PN usage, the recommendation isto use thisfield to
specify a suffix.
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Step4  Enter the required information for the | P address pool you are creating.
Step5  Click Save.

The Resource Pools window reappears with the new 1P address pool listed.

Creating a Multicast Pool

From the Create Multicast Pool window, you can create multicast pools. These pools are global and are
not associated with any provider or customer.

To create a multicast pool, follow these steps:

Stepl  Choose Service Inventory > Inventory and Connection Manager > Resour ce Pools.
Step2  Select Multicast from the Pool Type in the upper left of the Resource Pools window.
Step3  Click the Create button.

The Create Multicast Pool window appears, as shown in Figure 3-116.

Figure 3-116 Create Multicast Pool Window
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The Create Multicast Pool window contains the following fields:

« Multicast Address (required) Text field intheformat a.b.c.d/mask, for example 239.0.0.0/8. Range:
224.0.1.0/8 to 239.255.255.255/32.

» Usefor default MDT (optional) Thisis acheck box. Default: selected.

» Usefor Data MDT (optional) Thisis acheck box. The data MDT contains a range of multicast
group addresses and a bandwidth threshold. Thus, whenever a CE behind a multicast-VRF exceeds
that bandwidth threshold while sending multicast traffic, the PE sets up a new data MDT for the
multicast traffic from that source. The PE informs the other PEs about this data MDT and, if they
have receivers for the corresponding group, the other PEsjoin this data MDT. Default: selected.

Step4  Enter the required information for the multicast pool you are creating.
Step5  Click Save.
The Resource Pools window reappears with the new multicast pool listed.
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Creating a Route Distinguisher and Route Target Pool

Step 1
Step 2
Step 3

Step 4

MPL S-based VPNs employ Border Gateway Protocol (BGP) to communicate between PEs to facilitate
customer routes. This is made possible through extensions to BGP that carry addresses other than 1Pv4
addresses. A notable extension is called the route distinguisher (RD).

The purpose of the route distinguisher (RD) is to make the prefix value unique across the network
backbone. Prefixes should use the same RD if they are associated with the same set of route targets (RTS)
and anything else that is used to select routing policy. The community of interest association isbased on
the route target (RT) extended community attributes distributed with the Network Layer Reachability
Information (NLRI). The RD value must be aglobally unique value to avoid conflict with other prefixes.

The MPLS label is part of a BGP routing update. The routing update also carries the addressing and
reachability information. When the RD is unique across the MPLS VPN network, proper connectivity is
established even if different customers use non-unique | P addresses.

For the RD, every CE that has the same overall role should use a VRF with the same name, same RD,
and same RT values. The RDs and RTs are only for route exchange between the PEs running BGP. That
is, for the PEsto do MPLS VPN work, they have to exchange routing information with more fields than
usual for IPv4 routes; that extra information includes (but is not limited to) the RDs and RTs.

From the Create Route Distinguisher Pool window, you can create route distinguisher pools.
To create a route distinguisher pool, follow these steps:

Choose Service Inventory > Inventory and Connection Manager > Resour ce pools.

Select Route Distinguisher from the Pool Type in the upper left of the Resource Pools window.
Click the Create button.

The Create Route Distinguisher Pool window appears, as shown in Figure 3-117.

Figure 3-117 Create Route Distinguisher Pool Window
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The Create Route Distinguisher Pool window contains the following fields:
» RD Pool Start (required) Range: 0 to 2147483646.
» RD Pool Size (required) Range: 1 to 2147483647.
» Provider (required)
Enter the RD Pool Start and Size information for the route distinguisher pool you are creating.
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Step5  Click the Select button.

The Provider for new Resource Pool window appears, as shown in Figure 3-118.

Figure 3-118 Provider for New Resource Pool Window
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Step6  Select one of the providers listed and click Select.
Step7  Click Save.

The Resource Pools window reappears with the new route distinguisher pool listed.

To create a Route Target Pool, follow these steps:

Stepl  Choose Service Inventory > Inventory and Connection Manager > Resour ce pools.
Step2  Select Route Target from the Pool Type in the upper left of the Resource Pools window.
Step3  Click the Create button.

The Create Route Target Pool window appears, as shown in Figure 3-119.

Figure 3-119 Create Route Target Pool Window
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The Create Route Target Pool window contains the following fields:
« RT Pool Start (required) Range: 0 to 2147483646.
» RT Pool Size (required) Range: 1 to 2147483647.
» Provider (required)
Step4  Enter the RT Pool Start and Size information for the route target pool you are creating.
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Step5  Click the Select button.

The Provider for new Resource Pool window appears, as shown in Figure 3-120.

Figure 3-120 Provider for New Resource Pool Window
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Step6  Select one of the providers listed and click Select.
Step7  Click Save.

The Resource Pools window reappears with the new route target pool listed.

Creating a Site of Origin Pool

In MPLS VPN, CE sites use private/public AS numbers and when one AS number is used for each VPN,
all sites belonging to the same VPN share the same private/public AS number. The default BGP behavior
isto drop any prefix if itsown AS number is already in the AS path. As aresult, a customer site does
not learn prefixes of aremote site in this situation. AS-OVERRIDE must be configured (if there are hub
sites involved, ALLOWAS-IN must be configured) to allow those prefixes to be sent by PE routers but
arouting loop can occur.

For example, CE1 and CE2 belong to the same customer VPN and have the same AS number 65001. The
AS path between two customer sitesis 65001 - 1234 - 65001 and prefixes cannot be exchanged between
customer sites because AS 65001 is already in the path. To solve this problem, AS-OVERRIDE options
are configured on PE routers; but it introduces a routing loop into the network without using extended

community site of origin attributes.

Site of originisaconcept in MPLS VPN architecture that prevents routing loops in sites that are
multi-homed to the MPLS VPN backbone and in sites using AS-OVERRIDE in conjunction. Site of
originisatype of BGP extended community attribute used to identify a prefix that originated from asite
so that the re-advertisement of that prefix back to the site can be prevented. This attribute uniquely
identifies the site from which the PE router learned the route. Site of origin istagged at PE in peering
with BGP neighbors using an inbound route-map and works in conjunction with BGP CE-PE routing
protocol.

Site of origin must be unique per customer site per VPN/customer (when these sites are multi-homed).
Therefore, the same value of site of origin must be used on PE routers connected to the same CE router
or to the same customer site.

Note  Each time a customer siteis created, | SC generates a unique site of origin value from the selected site
of origin provider pool if Site of Originisenabled. Thissite of origin value must be unique per customer
site per customer/VPN.
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From the Create Site of Origin Pool window, you can create site of origin pools.

To create a site of origin pool, follow these steps:

Stepl  Choose Service Inventory > Inventory and Connection Manager > Resour ce pools.
Step2  Select Site of Origin from the Pool Type in the upper left of the Resource Pools window.
Step3  Click the Create button.

The Create Site of Origin Pool window appears, as shown in Figure 3-121.

Figure 3-121 Create Site of Origin Pool Window
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The Create Site of Origin Pool window contains the following fields:
» SOO Pool Start (required) Range: 0 to 2147483646.
» SOO Pool Size (required) Range: 1 to 2147483647.
« Provider (required)
Step4  Enter the SOO Pool Start and Size information for the site of origin pool you are creating.
Step5  Click the Select button.
The Provider for new Resource Pool window appears, as shown in Figure 3-122.

Figure 3-122 Provider for New Resource Pool Window
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Step6  Select one of the providers listed and click Select.
Step7  Click Save.
The Site of Origin pools window reappears with the new route target pool listed.
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Creating a VC ID Pool

From the Create VC ID Pool window, you can create VC ID pools. These pools are global and are not
associated with any provider or customer

To create aVC ID pool, follow these steps:

Stepl  Choose Service Inventory > Inventory and Connection Manager > Resour ce pools.
Step2  Select VC ID from the Pool Type in the upper left of the Resource Pools window.
Step3  Click the Create button.

The Create VC ID Pool window appears, as shown in Figure 3-123.

Figure 3-123 Create VC ID Pool Window
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The Create VC ID Pool window contains the following fields:
« VC Pool Start (required) Range: 1 to 2147483646.
« VC Pool Size (required) Range: 1 to 2147483647.
Step4  Enter the required information for the site of origin pool you are creating.
Step5  Click Save.
The VC ID Pools window reappears with the new VC ID pool listed.

Creating a VLAN Pool

From the Create VLAN Pool window, you can create VLAN pools.
To create a VLAN pool, follow these steps:

Stepl  Choose Service Inventory > Inventory and Connection Manager > Resour ce pools.
Step2  Select VLAN from the Pool Type in the upper left of the Resource Pools window.
Step3  Click the Create button.

The Create VLAN Pool window appears, as shown in Figure 3-124.
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Figure 3-124 Create VLAN Pool Window
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The Create VLAN Pool window contains the following fields:
« VLAN Pool Start (required) Range: 1 to 4094.
« VLAN Pool Size (required) Range: 1 to 4094.
» Access Domain (required)
Step4  Enter the VLAN Pool Start and Size information for the VLAN pool you are creating.

Step5  Click the Select button.
The Access Domain for new VLAN Pool window appears, as shown in Figure 3-125.

Figure 3-125 Access Domain for new VLAN Pool Window
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# Select

1. Sonera_Mccess Telia_Soners

Rows per page: 10 =

85292

Step6  Select one of the access domains listed and click Select.

Step7  Click Save.
The VLAN Pools window reappears with the new VLAN pool listed.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Deleting Resource Pools

Step 1
Step 2
Step 3

Step 4

Step 5

From the Resource Pool window, you can delete specific resource pools.

To delete resource pools, follow these steps:

Choose Service Inventory > Inventory and Connection Manager > Resour ce pools.
Select a pool type from the Pool Type in the upper left of the Resource Pools window.

Select one or more resource pools to delete by checking the check box(es) to the left of the resource
pool(s).

Click the Delete button.
The Confirm Delete window appears, as shown in Figure 3-126.

Figure 3-126 Confirm Delete Window

({%nfirm Delete

Confirm Delete
Showing 1-1 of 1 records
# P Address Pool Mask Size Type Pool Mame
1. 18.00.4 30 4194303  Region ServiceProvider! Region

Rows per page: 10 =

25297

Click the Delete button to confirm that you want to delete the resource pool(s) listed.

The Resource Pools window reappears with the specified pool(s) deleted.

CE Routing Communities

A VPN can be organi zed into subsets called CE routing communities, or CERCs. A CERC describes how
the CEsin aVPN communicate with each other. Thus, CERCs describe the logical topology of the VPN.
Cisco I P Solution Center can be employed to form avariety of VPN topol ogies between CEs by building
hub and spoke or full mesh CE routing communities. CERCs are building blocks that allow you to form
complex VPN topologies and CE connectivity.

The most common types of VPNs are hub-and-spoke and full mesh.

« A hub-and-spoke CERC is one in which one or afew CEs act as hubs, and all spoke CEs talk only
to or through the hubs, never directly to each other.

« A full mesh CERC is onein which every CE connects to every other CE.

These two basic types of VPNs—full mesh and hub and spoke—can be represented with asingle CERC.
Whenever you create a VPN, the Cisco | P Solution Center software creates one default CERC for you.
This means that until you need advanced customer layout methods, you will not need to define new
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CERCs. Up to that point, you can think of a CERC as standing for the VPN itself—they are one and the
same. If, for any reason, you must override the software’s choice of route target values, you can do so
only at the time you create a CERC in the Cisco | P Solution Center software.

To build very complex topologies, it is necessary to break down the required connectivity between CEs
into groups, where each group is either fully meshed, or has a hub and spoke pattern. (Note that a CE
can be in more than one group at atime, if each group has one of the two basic patterns.) Each subgroup
in the VPN wants its own CERC. Any CE that is only in one group just joins the corresponding CERC
(asaspokeif necessary). If a CE isin more than one group, then you can use the Advanced Setup choice
during provisioning to add the CE to all the relevant groups in one service request. Given this
information, the provisioning software does the rest, assigning route target values and VRF tables to
arrange exactly the connectivity the customer requires. You can use the Topology tool to double-check
the CERC memberships and resultant VPN connectedness.

Cisco I P Solution Center supports multiple CEs per site and multiple sites connected to the same PE.
Each CERC has unique route targets (RT), route distinguisher (RD), and VPN Routing and Forwarding
instance (VRF) naming. After provisioning a CERC, it is a good idea to run the audit reports to verify
the CERC deployment and view the topologies created by the service requests. The product supports
linking two or more CE routing communities in the same VPN.

This section describes how you can create and manage CE routing communities. This section includes
the following:

« Accessing the CE Routing Communities Window, page 3-133
« Creating CE Routing Communities, page 3-134
- Deleting CE Routing Communities, page 3-135

Accessing the CE Routing Communities Window

Step 1

The CE Routing Communities feature is used to create and manage CERCs.
To access the CE Routing Communities window, follow these steps:

Choose Service Inventory > Inventory and Connection Manager > CE Routing Communitiesto
access the CE Routing Communities window shown in Figure 3-127.

Figure 3-127 CE Routing Communities Window

CE Routing Communities

Show CERC with | Name =!I matching [* Find
Showing 1 - 2 of 2 records
2 Hame HRT SRT Provider YPM
1. I Mpls-vPN-1 991 94:2 Provider1 Mpls-WPR-1
2. T Mpls-vPN-2 98:3 99:4 Provider Mpls-YPM-2

Rows perpage:l 10 j 1€ ¢ Goto page:l1 of 1 [ [0

Create

149438
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From the CE Routing Communities window, you can create, edit, or delete CE routing communities
using the following buttons:

- Create Click to create new CE routing communities. Enabled only if no CE routing community is
selected.

- Edit Click to edit selected CE routing communities (select by checking the corresponding box).
Enabled only if one CE routing community is selected.

« Delete Click to delete selected CE routing communities (select by checking the corresponding
box(es)). Enabled only if one or more CE routing communities are selected.

Creating CE Routing Communities

When you create a VPN, the Cisco IP Solution Center software creates one default CE routing
community (CERC) for you. But if your network topology and configuration require customized CERC
definitions, you can define CERCs customized for your network.

Tip Customized CERCs should be defined only in consultation with the VPN network administrator. To
build complex topologies, it is necessary to break down the required connectivity between CEs into
groups, where each group is either fully meshed or has a hub-and-spoke pattern. A CE can be in more
than one group at atime, as long as each group has one of the two basic configuration patterns.

Each subgroup in the VPN wants its own CERC. Any CE that is only in one group just joins the
corresponding CERC (as a spoke if necessary). If a CE isin more than one group, then you can use the
Advanced Setup choice during provisioning to add the CE to all the relevant groups in one service
request. Given thisinformation, Cisco | P Solution Center does the rest, assigning route target values and
V RF tables to arrange the precise connectivity the customer requires.

To create a CE routing community, follow these steps:

Stepl  Choose Service Inventory > Inventory and Connection Manager > CE Routing Communities.
Step2  Click Create.
The Create CE Routing Community window appears, as shown in Figure 3-128.
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Figure 3-128 Create CE Routing Community Window

Create CE Routing Community

Prﬁfder Mame "™ |Pr|:|vider1

H
Mame

CERC Type: @ Hubr and Spoke
O Fully Meshed

Auto-pick route target values:

Route Target 1: |

Route Target 2 |

| Save H Cancel ‘

158156

Mote: * - Reguired Field

Step3  Complete the CERC fields as required for the CE Routing Community:
a. Provider Name (required) To specify the service provider associated with this CERC, click Select.
The Select Provider dialog box is displayed.
b. From this new window, choose the name of the service provider, then click Select.
c. Name (required) Enter the name of the CERC.
d. CERC Type Specify the CERC type: Hub and Spoke or Fully Meshed.

e. Auto-Pick Route Target Values Chooseto either let Cisco | P Solution Center automatically set the
route target (RT) values or set the RT values manually.

By default, the Auto-pick route target values check box is checked. If you uncheck the check box,
you can enter the Route Target values manually.

A

Caution  If you choose to bypass the Auto-pick route target values option and set the route target (RT) values
manually, note that the RT values cannot be edited after they have been defined in the ISC software.

Step4  When you havefinished entering the information in the Create CE Routing Community dial og box, click
Save.

After creating the CERC, you can add it to the VPN.

Deleting CE Routing Communities

From the CE Routing Community window, you can delete specific CERCs.
To delete CERC(s), follow these steps:

Stepl  Choose Service Inventory > Inventory and Connection Manager > CE Routing Communities

Cisco IP Solution Center Infrastructure Reference, 4.2
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Step 2
Step 3

Step 4

VPNSs

Select CERC(s) to delete by checking the check box(es) to the left of the CERC name.
Click the Delete button.

The Confirm Delete window appears.

Click OK to confirm that you want to delete the CERC(s) listed.

The CE Routing Communities window reappears with the specified CERC(s) deleted.

Atitssimplest, avirtual private network (VPN) isacollection of sitesthat share the same routing table.
A VPN isalso aframework that provides private | P networking over a public infrastructure such as the
Internet. In Cisco IP Solution Center: MPLS VPN Management, aV PN isaset of customer sitesthat are
configured to communicate through aV PN service. A VPN isdefined by aset of administrative policies.

A VPN isanetwork in which two sites can communicate over the provider’s network in aprivate manner;
that is, no site outside the VPN can intercept their packets or inject new packets. The provider network
is configured such that only one VPN’s packets can be transmitted through that VPN—that is, no data
can come in or out of the VPN unlessit is specifically configured to allow it. There is a physical
connection from the provider edge network to the customer edge network, so authentication in the
conventional sense is not required.

This section describes how you can create and manage pools for various types of resources. This section
includes the following:

» Accessing the VPNs Window, page 3-136
- Creating a VPN, page 3-137
» Deleting VPNs, page 3-140

Accessing the VPNs Window

Step 1

The VPN feature is used to create and manage various types of VPNs.
To access the VPN window, follow these steps:

Choose Service Inventory > Inventory and Connection Manager > VPN to access the VPN window
shown in Figure 3-129.
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Figure 3-129 VPNs Window

VPNs
Show VNS withlVF’N Narme ~| matehing | Find |
Showing 1 - 6 of 6 records
# [ YPN Hame Customer Name
1. Mpls-vPr-1 Customert
2. [ Mpls-wPr-2 Custormert
3. vpnd Customert
4. [ wpn2 Customert
5 I von3 Customer2
6. [ wpn4 Custamer?
Rows per page:lﬂ 1<] <] Goto page: [1 of 1 Bl

| Create || Edit || Delete |
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From the VPNs window, you can create, edit, or delete VPNs using the following buttons:
« Create Click to create new VPNs. Enabled only if no VPN is selected.

- Edit Click to edit a selected VPN (check the corresponding box). Enabled only if one VPN is
selected.

» Delete Click to delete selected VPN(s) (check the corresponding box(es)). Enabled only if one or
more VPNs is selected.

Creating a VPN

To create a VPN, follow these steps:

Stepl  Choose Service Inventory > Inventory and Connection Manager > VPN.
Step2  Click Create.
The Create VPN window appears, as shown in Figure 3-130.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 3-130 Create VPN Window

Create VPN
Ed
Mame : l
Customer: I | Select
MPLS attributes

Create Default CE Routing Cammunity. [ I Select Frovider -

Enahle hulticast: [
Enahle Auto Pick MDT Addresses: [«

Default MOT Address ™

(a.h.c.d

Data MDT Subnet:

|
|
Data MDT Size: I 0 -

{a.b.c.d)

Data MOT Threshald: | {1- 4294867 kilobitsfzec)
Default PIM Mode: | SPARSE_DENSE_MODE ~|
MOT MTU: | (aYE- 180100

Enahle PItd S5h: [ IDEFAULT =

S5M List Name ' |

Multicast Route Limit: |
Enahle Autc RP Listener: [~
Configure Static-RP: [~

FIM Static-RPs

Static-RP
Unicast Address

(1- 2147433647

Showing 0 of O records

Multicast-Group List Mame Owerride

Fows per page

e
:|1D j ﬂ(](]Gutupage:l'l of 1 (B8) [ [21

CE Routing Communities:

VYPLS Attributes
Enahle YPLS: [

sotent |
g ==

YN 1D |

Service Type: IERS -
Topology: I Full Mesh hd

(1-2147483646)

| Save | Cancel

Mote: * - Required Field

149139

Step3  Complete the fields as required for the VPN:

Name (required) Enter the name of the VPN.

a.
b. Customer (required) To select the customer

o

associated with this VPN, choose Select.

From the list of customers, select the appropriate customer, then click Select.

d. If youwant MPLS attributes, complete the fieldsin the MPL S Attributes section of the window. For

VPLS, skip to step t.

] Cisco IP Solution Center Infrastructure Reference, 4.2
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Create Default CE Routing Community (optional) To create a default CE routing community,
check the Create Default CE Routing Community check box and select a provider.

Enable Multicast To enable multicast VPN routing, check the Enable M ulticast check box.

An | P addressthat startswith the binary prefix 1110 isidentified asamulticast group address. There
can be more than one sender and receiver at any time for a given multicast group address. The
senders send their data by setting the group address as the destination | P address. It is the
responsibility of the network to deliver this datato all the receiversin the network who are listening
to that group address.

~

Note  Beforeyou can create a VPN with multicast enabled, you must define one or more multicast
resource pools.

Enable Auto Pick MDT Addresses (optional) To enable auto picking MDT addresses, check the
Enable Auto Pick MDT Addresses check box.

Default MDT Address If Enable Auto Pick MDT Addressesis set on, Default MDT Addressis
required.

Data MDT Subnet (optional)

Data MDT Size (optional) If Enable Multicast is set on, Data MDT Sizeis required. From the
drop-down list, select the data MDT size.

MDT refersto a multicast distribution tree (MDT). The MDT defined here carries multicast traffic
from customer sites associated with the multicast domain.

DataMDT Threshold (optional) If Enable Multicast isset on, DataMDT Threshold isrequired.
Enter the bandwidth threshold for the data multicast distribution tree.

The data MDT contains a range of multicast group addresses and a bandwidth threshold. Thus,
whenever a CE behind a multicast-V RF exceeds that bandwidth threshold while sending multicast
traffic, the PE setsup anew dataMDT for the multicast traffic from that source. The PE informsthe
other PEs about this data MDT and, if they have receivers for the corresponding group, the other
PEs join this dataMDT.

Default PIM M ode (optional)
Enable PIM SSM (optional)

SSM List Name

Multicast Route Limit (optional)
Enable Auto RP Listener (optional)
Configure Static-RP (optional)

CE Routing Communities (optional) If Enable Multicast is set on, CE Routing Communitiesis
required. If you do not choose to enable the default CERC, you can select a customized CERC that
you have already created in 1SC. From the CE Routing Communities pane, click Select.

The Select CE Routing Communities dialog box is displayed.
Check the check box for the CERC you want used for this service policy, then click Select.

You return to the Create VPN dialog box, where the new CERC selection is displayed, along with
its hub route target (HRT) and spoke route target (SRT) values.

If you want VPLS attributes, the optional fields for that are in u. to x.
Enable VPL S (optional) Check this check box to enable VPLS.

| oL-10727-01
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Step 4

v. VPN ID (optional)

w. Service Type (optional) Click the drop-down list and choose from ERS (Ethernet Relay Service) or
EWS (Ethernet Wire Service).

x. Topology (optional) Select the VPLS topology from the drop-down list: Full Mesh (each CE will
have direct connections to every other CE) or Hub and Spoke (only the Hub CE has connection to
each Spoke CE and the Spoke CEs do not have direct connection to each other).

When satisfied with the settings for this VPN, click Save.

You have successfully created aV PN, as shown in the Status display in the lower left corner of the VPNs
dialog box.

Deleting VPNs

Step 1
Step 2
Step 3

Step 4

From the VPNs window, you can delete specific VPNSs.
To delete VPN(s), follow these steps:

Choose Service Inventory > Inventory and Connection Manager > VPN.

Select VPN(s) to delete by checking the check box(es) to the left of the VPN name.
Click the Delete button.

The Confirm Delete window appears.

Click OK to confirm that you want to delete the VPN(s) listed.

The VPNs window reappears with the specified VPN(s) deleted.

Named Physical Circuits

Named physical circuits (NPCs) are named circuits that describe a physical connection between a CPE
or U-PE and an N-PE. The intermediate nodes of the NPCs can either be CPE or PE. They can be
connected in acircular fashion forming aring of devices, which is represented by an entity known as
NPC Rings. NPC Rings represent the circular topology between devices (CPE or PE) to the Named
Physical Circuits. To create an NPC, you must specify how the source CPE/U-PE and the destination
N-PE are connected and specify the intermediate nodes.

The connectivity of the NPCs is defined by specifying a set of devices serving as physical links; each
device has two interfaces that are part of the NPC connections. The Incoming Interface defines the
interface from the CE direction. The Outgoing I nterface defines the interface toward the PE direction.

You can also add (meaning after the chosen device) or insert (meaning before the chosen device) an NPC
Ring in the link.

Keep in mind the following when you are creating an NPC:

» InthelSC software, the device you select can be any node in the link. The | SC software only shows
the appropriate devices. Thefirst device must be a CPE or U-PE and the last device must be an N-PE.
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» NPCsshould be created before the MPL S multi-device, VPLS, or L2V PN servicerequest is created
with cpel and pel. So when you create the SR, you would select the policy, cpel, pel, and the NPC
that defines the link between cpel and pel.

This section describes how you can create and delete NPCs and create, edit, and delete NPC Rings. This
section includes the following:

» Accessing the Named Physical Circuits Window, page 3-141
» Creating a Named Physical Circuit, page 3-142

» Deleting Named Physical Circuits, page 3-146

« Creating NPC Rings, page 3-146

» Editing NPC Rings, page 3-150

- Deleting NPC Rings, page 3-150

Accessing the Named Physical Circuits Window

The Named Physical Circuits feature is used to create and delete NPCs. You cannot edit or modify.
To access the Named Physical Circuits window, follow these steps:

Step1  Choose Service Inventory > Inventory and Connection Manager > Named Physical Circuitsto
access the window shown in Figure 3-131, “Named Physical Circuits Window.”

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 3-131 Named Physical Circuits Window
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Rows per page: | 10+ 1] ] Go to page: 1 of 2 (21
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From the Named Physical Circuits window, you can create or delete NPCs using the following buttons:
» Create Click to create new NPCs. Enabled only if no NPC is selected.

- DeleteClick to delete selected NPC(s) (select by checking the corresponding box(es)). Enabled only
if one or more NPCs are selected.

Creating a Named Physical Circuit

To add an NPC physical link, follow these steps:

Stepl  Choose Service Inventory > Inventory and Connection Manager > Named Physical Circuit.

Step2  Click the Create button in Figure 3-131, “Named Physical Circuits Window,” and a window, as shown
in Figure 3-132, “Create a Named Physical Circuit Window,” appears.
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Figure 3-132 Create a Named Physical Circuit Window

Create a Hamed Physical Circuit

# Device Incoming Interface Outgoing Irterface Ring

Add Device Add Ring Save Cancel

116254

Each line represents a physical link and each physical link contains the following attributes:
- Device
- Incoming Interface
« Outgoing Interface
« Ring (optional)
>

Note  Beforeadding aringin an NPC, create aring and save it in the repository, as explained in the
“Creating NPC Rings” section on page 3-146.

~

Note  An NPC must have at least one link defined. The link must have two Devices, an Incoming
Interface, and an Outgoing Interface.

Step3  Click Add Deviceor Insert Device and a window as shown in Figure 3-133, “ Select Device Window,”
appears.

Figure 3-133 Select Device Window

ShDWICPE | devices u\therelDe‘\"iCE Name ¥ matehing r‘ | Find |

Showing 1- 3 of 3 records

# Device Hame Customer Mame Site Mame Man_ﬁ:gnent
1.  celd Customer east MANAGED
2 (" celd Custamer east MANAGED
3. (7 ced Customer east MANAGED

Rows perpage:lm =| 14 Goto page:|1 of 1 |

| Select || Cancel |
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Step4  Be surethat the drop-down list in Show is CPE or PE. Click aradio button next to a device and then
click Select.
Step5  Figure 3-132, “Create a Named Physical Circuit Window,” reappears with the chosen Device.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 3-134 Create Named Physical Circuit Window

Create a Hamed Physical Circuit

# Jevice Incoming Interface Outgoing |rterface Ring

2.

11625%

Step6  If youwant to add adeviceto your NPC asthe last item or after the item checked in the check box, click
the Add Device button in Figure 3-132 on page 3-143 and then add device and interface information as
explained in the previous steps. If you want to insert adevice to your NPC as the first item or before the
item checked in the check box, click the Insert Device button in Figure 3-132 on page 3-143 and then
add device and interface information as explained in the previous steps.

Step7  Inthe Outgoing Interface column in this new version of Figure 3-132, “Create a Named Physical
Circuit Window,” click Select outgoing interface and a window as shown in Figure 3-135, “ Select
Outgoing Interface Window,” appears with alist of interfaces.

Figure 3-135 Select Outgoing Interface Window

Interfaces far device encel

ShowDevice Interfaces with | INterface Name  >| matehing |

Showing 1-6 of 6 records

#  Select Interface Logical Mame

1. Ethernetn 192 168.129.189/30
2. Ethernet1 192.168.1329/29
3. Loopbackd 192.168.115.70432
4. Loophack1 14111432
a. Seriall

B. Seriall

Rows per page: | 10 = 1<] <] Goto page: 1 of1 (Ga) [>[»]
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Step8  Click aradio button next to the interface to be the source interface for this NPC and then click Select.
Step9  Figure 3-132, “Create a Named Physical Circuit Window,” reappears with the chosen I nterface.

Step 10  Inthe Incoming Interface column in this new version of Figure 3-132, “Create a Named Physical
Circuit Window,” click Select incoming interface and awindow as shown in Figure 3-136, “ Select
Incoming Interface Window,” appears with alist of interfaces.
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Step 13

Note

Step 14
Step 15
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Figure 3-136 Select Incoming Interface Window
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Click aradio button next to the interface to be the incoming interface for this NPC and then click Select.

Figure 3-132, “Create a Named Physical Circuit Window,” reappears with the chosen Incoming
Interface.

If you created an NPC ring that you want to insert or add into this NPC, as explained in the “ Creating
NPC Rings” section on page 3-146, you can click Insert Ring or Add Ring and the ring appears at the
beginning or before the item checked in the check box for Insert Ring or the ring appears at the end or
after the item checked in the check box for Add Ring, as shown in Figure 3-137, “ Select NPC Ring
Window.”

When inserting aring, select the source device of the ring that connects to a source device or an NPC
and the destination device of the ring that connects to the destination device of the NPC.

If you have not created an NPC ring that you want to insert into this NPC, proceed to Step 17.

Figure 3-137 Select NPC Ring Window

ShowNPES rings | with Ring Marme *| matching |
Showing 1-1 of 1 records
# Select
1. 1-enpel -Ethernet 20
Rowe per pages: | 10+ [<] €] Goto page: [1 of1 [Ga) [» [2]
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Click aradio button next to the ring you choose and then click Select.
Figure 3-132, “Create a Named Physical Circuit Window,” reappears with the chosen Ring.

| oL-10727-01
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Step 16

Step 17

Select the missing devices and interfaces as explained in the “ Creating NPC Rings” section on
page 3-146.

Click Cancel if you do not want to save this information, and you will proceed to the previous window.

Otherwise, click Save. Figure 3-132, “Create a Named Physical Circuit Window,” reappears with the
new NPC listed.

Deleting Named Physical Circuits

Step 1

Step 2
Step 3

Note

Step 4

To delete NPC(s), follow these steps:

Choose Service Inventory > Inventory and Connection Manager > Named Physical Circuitsto
access the window shown in Figure 3-131, “Named Physical Circuits Window.”

Select one or more NPCs to delete by checking the check box(es) on the left.
Click the Delete button.
The Delete NPC window appears.

If the specified NPC is being used by any of the Service Requests, you will not be allowed to deleteit.
An error message appears explaining this.

Click the Delete button to confirm that you want to delete the NPCs listed.
Figure 3-131, “Named Physical Circuits Window,” reappears with the specified NPCs del eted.

Creating NPC Rings

Step 1

To create NPC rings, follow these steps:

Choose Service Inventory > Inventory and Connection Manager > NPC Rings and awindow as
shown in Figure 3-138, “NPC Rings Window,” appears.

Figure 3-138 NPC Rings Window

H P_I.L: Rings
Shovy MPC rings wwith name matching *
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# [ ] Hame
Rows per page: | 10+ <] €] Goto page: 1 of 1 U [0
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Step 2

Note

Step 3
Step 4

Note

Step 5
Step 6

Note

Step 7

Named Physical Circuits 1l

Click the Create button and a window as shown in Figure 3-139, “Create Ring Window,” appears.

A ring has a minimum of three physical links that form aring.

Figure 3-139 Create Ring Window

Create Ring

# Source Device Source Interface Destination Device Drestination |rterface
1. Select source interface Select destination interface
2. Select source interface Select destination interface
3. Select source interface Select destingtion interface
Edit Cross Links Save Cancel

116311

At any time, if you click Cancel, everything you have chosen disappears.

Start with the first line, which represents the first physical link.

In the Source Device column, click Select source device and a window as shown in Figure 3-140,
“Select Source Device — CPE/PE Window,” appears.

The CPE you choose must be a Multi-VRF CE.

Figure 3-140 Select Source Device — CPE/PE Window

ShDWICPE [ | I:hawficesxn\rherelDE\-’iCe Name >l matehing I’" | Find |

Showing 1 - 3 of 3 records

# Device Naime Custorner Name Site Narne Ma”??;gnem
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2. (" ced Customeri east MWANAGED
3. ced Customer east MWANAGED

Rows perpage:lw =l 1< < Goto page:|1 of 1 =20

| Select || Cancel |

149443

Click aradio button next to the device to be the source device for this physical link and then click Select.

Figure 3-139, “Create Ring Window,” reappears with the chosen Sour ce Device.

When choosing the Source Device for a physical link, this same choice is made for the Destination
Device for the previous physical link (or the last physical link if you are choosing for the first physical
link). For a selected device, do not select the same interface for the source and destination interface.

Inthe Sourcel nterface columninthisnew version of Figure 3-139, “ Create Ring Window," click Select
source inter face and a window as shown in Figure 3-141, “ Select Source Interface Window,” appears
with alist of interfaces.

| oL-10727-01
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Step 8

Step 9
Step 10

Step 11

Step 12

Note

Step 13

Figure 3-141 Select Source Interface Window

Interfaces for device ced3

Showe Device Interfaces with |nt9ﬁace[§ame | matching *

# Interface Hame IP Address Logical Mame
1. () Ethernetd 172.29.146.36/26
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Click aradio button next to the interface to be the source interface for this physical link and then click
Select.

Figure 3-139, “Create Ring Window,” reappears with the chosen Sour ce I nterface.

In the Destination Device column in this new version of Figure 3-139, “Create Ring Window,”, click
Select destination device and awindow as shown in Figure 3-142, “ Select Destination Device —
CPE/PE Window,” appears.

Figure 3-142 Select Destination Device — CPE/PE Window
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Showing 1 - 3 of 3 records
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| Select || Cancel |
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Click aradio button next to the device to be the destination device for this physical link and then click
Select.

Figure 3-139, “Create Ring Window,” reappears with the chosen Destination Device.

When choosing the Destination Device for the a physical link, this same choice is made for the next
Sour ce Device. Do not choose the same Interface for these devices.

In the Destination I nter face column in this new version of Figure 3-139, “Create Ring Window,” click
Select destination interface and a window as shown in Figure 3-143, “ Select Destination Interface
Window,” appears with alist of interfaces.
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Step 14

Step 15
Step 16
Step 17

Step 18

Step 19

Step 20

Step 21

Named Physical Circuits 1l

Figure 3-143 Select Destination Interface Window
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Click aradio button next to the interface to be the destination interface for this NPC and then click
Select.

Figure 3-139, “Create Ring Window,” reappears with the chosen Destination | nterface.
Repeat Step 4 to Step 15 for the middle physical links and Step 4 to Step 9 for the last physical link.

If you want to insert an extra physical link in the ring, check the check box for the line that represents
the physical link you want the new physical link to follow and click I nsert. Implement Step 4 to Step 15
to fill in the remaining entries in this new physical link.

If you want to delete a physical link in the ring but aminimum of three physical linkswill remain, check
the check box for the line that represents the physical link you want to delete and click Delete.

If you want to establish additional cross links between non-adjacent devices in thisring, you can click
Edit CrossLinksin Figure 3-139, “Create Ring Window,” and you then view a new window like
Figure 3-139 with no entry. Click the Add button and you can choose from the devices already in your
ring. Theresult is anew entry in Figure 3-139 with this device as the Sour ce Device. Establish the
Destination Device and Source and Destination Interfaces as you did when creating the ring. The choices
of devices and interfaces is limited to those already established in your ring.

~

Note  To Edit Cross Links, aminimum of four devicesis needed to form thisring.

Click Cancel if you do not want to save this information, and you will proceed to the previous window.

Otherwise, when you have completed setting up your ring click Save. The new ring is added in
Figure 3-138, “NPC Rings Window,” and a green check for Succeeded appears. The new ring is
identified by the source device-source interface.

To create aring with more than three physical links, check the check box for thelink in Figure 3-139 on
page 3-147 to which you want to insert and the I nsert button is then enabled. Proceed in adding links as
explained in this section.

| oL-10727-01
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Editing NPC Rings
To edit NPC rings, follow these steps:

S

Note If the specified NPC Ring is participating in any of the Named Physical Circuits, then you can not edit
the ring. An error message appears containing IDs of the NPCs that contain the NPC Ring.

Stepl  Choose Service Inventory > Inventory and Connection Manager > NPC Rings and a window as
shown in Figure 3-144, “NPC Rings Window,” appears.

Figure 3-144 NPC Rings Window

HPC Rings

ShowMPC rings with name matching ¢

Showing 1-1 of 1 records

Rows per page: | 10 = <] <] Goto page: 1 of 1 (Ga) [» ]

10149849

Step2  Check the check box next to thelinethat represents an NPC ring and then click Edit. A window as shown
in Figure 3-139, “Create Ring Window,” appears with all the data for thisring. Proceed asin the
“Creating NPC Rings’ section on page 3-146 to make any changes you want.

Step3  When you have the ring as you want it, click Save.

Step4  Figure 3-138, “NPC Rings Window,” appears with the appropriate name (source device-source
interface) and a green check for Succeeded appears.

Deleting NPC Rings

To delete NPC rings, follow these steps:

~

Note  If the specified NPC Ring is participating in any of the Named Physical Circuits, then you can not delete
the ring. An error message appears containing IDs of the NPCs that contain the NPC Ring.

Stepl  Choose Service Inventory > Inventory and Connection Manager > NPC Rings and a window as
shown in Figure 3-145, “NPC Rings Window,” appears.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 3-145 NPC Rings Window
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Step2  Check the check box(es) next to the line(s) that represent(s) NPC ring(s) that you want to del ete and then
click Delete. A window as shown in Figure 3-146, “ Delete Rings Window,” appears with the chosen
ring(s) for deletion.

Figure 3-146 Delete Rings Window

Delete Ring(s)

Confim Delete
Showing 1-1 of 1 records
#
1. 2-encel1-Ethernetd
Rows per page: | 10 [<] <] Goto page: 1 of1 [Ga) [» [2]

Dzl ete Cancel

101991

Step3  Click Cancel if you change your mind about del eting the chosen ring(s) or click Deleteto actually delete
the ring.

Step4  Figure 3-145, “NPC Rings Window,” appears with the remaining ring names and a green check for
Succeeded appears.

Cisco IP Solution Center Infrastructure Reference, 4.2
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